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LICENSE AGREEMENT 
 

 
IMPORTANT: PLEASE READ THE TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT 

CAREFULLY BEFORE USING ANY DEMONSTRATION OR FULL VERSION SOFTWARE 
OWNED BY  CRISTALLIGHT  AND/OR ITS SUBSIDIARIES (“CRISTALLIGHT”).  
CRISTALLIGHT IS WILLING TO LICENSE SOFTWARE TO YOU AS THE INDIVIDUAL, 
THE COMPANY, OR THE LEGAL ENTITY THAT WILL BE UTILIZING THE SOFTWARE 
(REFERENCED BELOW AS “YOU OR YOUR”) ONLY ON THE 
CONDITION THAT YOU ACCEPT ALL OF THE TERMS OF THIS LICENSE AGREEMENT.  
THIS IS A LEGAL AND ENFORCEABLE CONTRACT BETWEEN YOU AND CRISTALLIGHT 
SOFTWARE.  BY  CLICKING ON THE “AGREE” OR “YES” BUTTON OR OTHERWISE 
INDICATING ASSENT ELECTRONICALLY, OR LOADING THE SOFTWARE, YOU AGREE 
TO THE TERMS AND CONDITIONS OF THIS AGREEMENT.  IF YOU DO NOT AGREE TO 
THESE TERMS AND CONDITIONS, CLICK ON THE “I DO NOT AGREE”, “NO” BUTTON, OR 
OTHERWISE INDICATE REFUSAL, MAKE NO FURTHER USE OF ANY SOFTWARE FOR 
WHICH YOU HAVE NOT OBTAINED A LICENSED, AND IMMEDIATELY DESTROY ALL 
SUCH COPIES OF THE SOFTWARE THAT MAY BE IN YOUR POSSESSION OR UNDER 
YOUR CONTROL. 

 
 
1. License.  The software which accompanies this license (collectively the “Software”) is the property of 
Cristallight or its licensors and is protected by co pyright law.  While Cristallight continues 
to own the Software, you will have certain rights to use the Software after your acceptance of this license.  
This license governs any releases, revisions, or enhancements to the Software that Cristallight may 
furnish to you.  Except as may be modified by a Cristallight license certificate, license coupon, or 
license key (each a “License Document”) which accompanies, precedes, or follows this license, your rights 
and obligations with respect to the use of this Software are as follows: 
 
You may: 
 
A. use one copy of the Software on a single computer.  If a License Document accompanies, precedes, or 

follows this license, you may make that number of copies of the Software licensed to you by Cristallight
 as provided in your License Document.  Your License Document shall constitute proof 
of your right to make such copies. 

B. make one copy of the Software for archival purposes, or copy the Software onto the hard disk of your 
computer and retain the original for archival purposes; 

C. use the Software on a network, provided that you have a licensed copy of the Software for each 
computer that can access the Software over that network; and 

D. after written notice to Cristallight, transfer the S oftware on a permanent basis to another 
person or entity, provided that you retain no copies of the Software and the transferee agrees to the 
terms of this license. 

 
You may not: 
 
A. copy the printed documentation which accompanies the Software; 
B. sublicense, rent, or lease any portion of the Software; reverse engineer, decompile, disassemble, 

modify, translate, or make any other attempt to discover the source code of the Software; or create 
derivative works from the Software; 

C. use a previous version or copy of the Software after you have received a disk replacement set or an 
upgraded version.  Upon upgrading the Software, all copies of the prior version must be destroyed;  
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D. use a later version of the Software than is provided herewith unless you have pu rchased upgrade 
insurance or have otherwise separately acquired the right to use such later version; or 

E. use, if you received the software distributed on media containing multiple Cristallight 
products, any Cristallight on the media for which you have not received a permission 
in a License Document. 

 
2. Return Policy. It is the responsibility of the user to test and evaluate the suitability of the software for the 
intended purpose by downloading and reviewing the demonstration versi on of this software. ONCE A 
FULL VERSION OF THE SOFTWARE HAS BEEN DOWNLOADED AND THE USER FEE PAID, 
AND A PRODUCT KEY HAS BEEN PROVIDED TO THE USER, THE TRANSACTION IS FINAL 
AND NO REFUND WILL BE PROVIDED UNLESS: 
A. There are defects in the software that c annot be evaluated or detected by using the demonstration 

version of the software, and 
B.  Cristallight is notified of these defects within sixty (60) days from the date of purchase, and 
C. Cristallight does not correct these defects within tw enty (20) business days and provide the 

user with a version of the software with the defects corrected. 
 
3. Limited Warranty. If this software is distributed on physical media, Cristallight warrants that the 
media on which the Software is distributed will be free from defects for a period of sixty (60) days from the 
date of delivery of the Software to you.  Your sole remedy in the event of a breach of this warranty will be 
that Cristallight will, at its option, replace any defective media retu rned to Cristallight
within the warranty period or refund the money you paid for the Software.  Cristallight does not 
warrant that the Software will meet your requirements or that operation of the Software will be 
uninterrupted or that the Software will be error-free. 
 
THE ABOVE WARRANTY IS EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES,  
WHETHER EXPRESS OR IMPLIED, INCLUDING THE IMPLIED WARRANTIES OF  
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NON INFRINGEMENT OF 
INTELLECTUAL PROPERTY RIGHTS.  THIS WARRANTY GIVES YO U SPECIFIC LEGAL  
RIGHTS.  YOU MAY HAVE OTHER RIGHTS, WHICH VARY FROM STATE TO STATE AND 
COUNTRY TO COUNTRY. 
 
4. Disclaimer of Damages.  SOME STATES AND COUNTRIES, INCLUDING MEMBER COUNTRIES 
OF THE EUROPEAN ECONOMIC AREA, DO NOT ALLOW THE LIMITATION OR EXCLUSION OF 
LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE BELOW LIMITATION 
OR EXCLUSION MAY NOT APPLY TO YOU. 
 
TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW AND REGARDLESS OF  
WHETHER ANY REMEDY SET FORTH HEREIN FAILS OF ITS ESSENTIAL PURPOSE, IN  NO 
EVENT WILL CRISTALLIGHT OR ITS LICENSORS BE LIABLE TO YOU FOR ANY  
SPECIAL, CONSEQUENTIAL, INDIRECT, OR SIMILAR DAMAGES, INCLUDING ANY LOST 
PROFITS OR LOST DATA ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE, 
EVEN IF CRISTALLIGHT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH  
DAMAGES. 
 
IN NO CASE SHALL CRISTALLIGHT’S OR ITS LICENSORS’ LIABILITY EXCEED THE 
PURCHASE PRICE FOR THE SOFTWARE.  The disclaimers and limitations set forth above will apply 
regardless of whether you accept the Software. 
 
5. U.S. Government Restricted Rights.  RESTRICTED RIGHTS LEGEND.  All Cristallight 
products and documentation are commercial in nature.  The software and software documentation are 
“Commercial Items”, as that term is defined in 48 C. F.R. section 2.101, consisting of “Commercial 
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Computer Software” and “Commercial Computer Software Documentation”, as such terms are defined in 
48 C.F.R. section 252.227 -7014(a)(5) and 48 C.F.R. section 252.227 -7014(a)(1), and used in 48 C.F.R. 
section 12.212 and 48 C.F.R. section 227.7202, as applicable.  Consistent with 48 C.F.R. section 12.212, 48 
C.F.R. section 252.227 -7015, 48 C.F.R. section 227.7202 through 227.7202 -4, 48 C.F.R. section 52.227 -
14, and other relevant sections of the Code of Federal Reg ulations, as applicable, Cristallight’s 
computer software and computer software documentation are licensed to United States Government end 
users with only those rights as granted to all other end users, according to the terms and conditions 
contained in this license agreement.  Manufacturer is Cristallight, 915 Country Side Drive, 
Palatine, Illinoice 60067. 
 
6. General.  This Agreement will be governed by the laws of the United States and the State of Minnesota 
where consistent ther ewith.  Otherwise, this agreement will be governed by the laws of England. This 
Agreement and any related License Document is the entire agreement between You and Cristallight  
relating to the Software and: (i) supersedes all prior or contemporaneous  oral or written communications, 
proposals, and representations with respect to its subject matter; and (ii) prevails over any conflicting or 
additional terms of any quote, order, acknowledgment, or similar communications between the parties.  
This Agreeme nt may only be modified by a License Document or by a written document that has been 
signed by both You and Cristallight .  This Agreement shall terminate upon Your breach of any term 
contained herein and You shall cease use of and destroy all copies  of the Software.  The disclaimers of 
warranties and damages and limitations on liability shall survive termination. 
 
If you have any questions concerning this Agreement, or if you desire to contact Cristallight  for any 

reason, please write Cristallight  Customer Service, 915 Country Side Drive, Palatine, 
Illinoice 60067, USA, or call 413-383-0596. 
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Introduction
Welcome to Publisher Pro. With this powerful yet easy to use desktop publishing system you

are able to create many types of professional quality documents for virtually any purpose:
brochures, business cards, invitations, memos, newsletters, envelopes and more! It combines pow-
erful text editing and graphics capabilities. Full documentation is provided in this manual, and in
the on-line help file.

How to use this Manual

You should begin with the Installation instructions. Following these instructions carefully will
assure that DesktopPublisher Pro is properly installed and ready to run on your computer system.

The FAST OVERVIEW section describes the various components that make up the Publisher
Pro application. The TUTORIAL provides step-by-step lessons which allow you to create your first
documents. It covers the basics of how to use Publisher Pro to create a document from a ready-
to-use template file. It then describes how to create a document from scratch, place on your docu-
ment various objects and design elements and manipulate those objects using the Publisher Pro
tools. 

DesktopPUBLISHER PRO IN DEPTH covers the advanced features that this program has to o ffer.
DesktopPublisher Pro in Depth is divided into sections covering functions for document management
and printing.

The DesktopPublisher Pro MENU REFERENCE section describes the menu commands, the Online
Help, and the Balloon Help. Use it as a quick reference to the details of specific commands.

Conventions Used in this Manual

This manual assumes that you are familiar with the Macintosh operating system and the general
terms and conventions associated with it. In particular, it assumes that you understand the use of the
standard Macintosh pull-down menus and dialog boxes, how to enter text into text fields and how
to work with basic graphics objects. If you are not familiar with these concepts, consult your
Macintosh manuals before using DesktopPublisher Pro.

The RETURN and ENTER keys can be used interchangeably in DesktopPublisher Pro. The ENTER
key is used throughout the manual.

Pay special attention to items in italics. Items printed in italics are either definitions of words,
important steps or cautionary notes.

Keyboard commands and keyboard keys are printed “Cmd-A.” In this case you would hold down
the Command (   )key and press A.

1
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Installation
DesktopPublisher Pro is distributed on a CD-ROM.  The system requirements printed on the back of

the box reflect the system requirements for the current version of DesktopPublisher Pro. Extra hard
drive space is necessary to store the DesktopPublisher Pro clipart libraries which contain a wealth of
images.

2
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Fast Overview
This section provides a quick overview of DesktopPublisher Pro. The concepts presented in this sec-

tion will be used in the Tutorial section. While going through the tutorial in the tutorial section, you
may need to refer back to concepts and descriptions presented in this section.

Welcome to DesktopPublisher Pro, a comprehensive application allowing you to seamlessly integrate
text, graphics and other design elements to create sophisticated documents for business and home.
It is designed to provide you with all the features of major “power -house” desktop publishing pro-
grams without the accompanying complexity and cost.

With DesktopPublisher Pro you are able to:

• create a new document either from scratch or from any type of predefined templates that are
distributed along with DesktopPublisher Pro. The template types are: Brochure, Business Card,
Certificate, Envelope, Facsimile, Flyer , Greeting Card, Invitation, Invoice, Letter Head,
Memo, and Newsletter,

• import graphics in various graphic formats into your documents, allowing resizing and other
transformations without any loss of quality

• print all, even, or odd pages of your documents with crop marks, and color separations

• Preview the printer output using the ColorSync preview option

• place any text on your documents and add special effects, such as stretching, outlining, fill-
ing with blend, and shadowing

• use powerful search text and style features

• link text boxes, creating “text chains”

• create, edit and use Style Sheets

• add, edit and delete colors used in your documents

• add and manipulate the objects on your documents, aligning them and changing their stack-
ing order on a page

• add special “Speech Balloons” design elements

• apply colors to virtually any design element’ s foreground and background, draw various
graphic elements in any width, color or pattern

• import graphics created with other applications

• change the view scale

• easily navigate through the document pages and add and delete pages

• use powerful Master Pages support

• use DesktopPublisher Pro spell checking, thesaurus, rhyming capabilities, text hyphenation, and
more

3
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The text editor allows you to produce text in different fonts, colors, styles, and sizes. Control line
spacing (leading) of text and produce text boxes of dif ferent sizes and orientation. Control align-
ment of text on the page. 

Power Text objects allow you to add special effects. Text in such objects fills the entire text box,
expanding or contracting as necessary, but always extending to the outermost boundaries of the box.
The more text you enter, the more compressed the letters will be in the power text box. If your text
is too compressed, you can resize the power text object to a lar ger size. Special ef fects can be
applied to your power text. The text can be squeezed, arched, slanted, stretched, colored, and manip-
ulated in various ways.

Many graphic images are included in the DesktopPublisher Pro graphics libraries, and graphics
objects in various graphic formats can be imported into your document. DesktopPublisher Pro relies on
the Macintosh Translation Manager capabilities allowing you to import up to thirty graphic formats.
In case the  Translation Manager is not installed, DesktopPublisher Pro supports the import of  TIFF,
PICT, EPS, QuickT ime, PNTG and GIF images. You can also import and export graphics to and
from other applications using the Clipboard. You can rotate any object to any angle.

Your document can be exported either as a plain text document or an HTML file. This enables
you to open the exported document with any web browser .

The combination of these features provides a single application to create all the diversity of the
printing products for any need.

Note: the appearance of the DesktopPublisher Pro interface elements may di ffer from the pictures
used in this manual by the look and color of controls. The program allows switching between the
DesktopPublisher Pro appearance, and the  Apple Platinum and other appearances available on your
computer by simultaneous pressing the Command + Option + Control modifier keys, and the ‘0’
(zero) key.

Pull-down Menus

Designed as a standard Macintosh application, DesktopPublisher Pro displays a set of pull down
menus in the menu bar at the top of the computer screen. Pull-down menus are activated by hold-
ing the mouse button down on the title of the menu and dragging down with the mouse pointer to
highlight the desired item. Some items in some of the pull-down menus activate sub-menus: a sub-
menu becomes activated when the primary menu item is highlighted. 

The pull down menus:

File Contains submenus and options for creating, opening and saving documents; import-
ing data from other sources and exporting to other formats; document attributes con-
trol, and printing.

Edit Contains menu options for editing objects, text, colors, toolbars, ruler and guide set-
tings, also for changing the application behavior by modifying preferences.

4
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Object Allows various options for working with objects placed on a document. Displays full
information about an object’s current location and position, its colors, shades, and pat-
terns. Deletes, duplicates, groups and ungroups objects. Also contains additional
options for aligning objects and changing the objects stacking order on an active page.

Text Contains a comprehensive text editor capability, and provides access to the important
text utilities such as spell checking, thesaurus and rhyming. 

Graphics Contains a full set of options for graphic object appearance control, including line, fill,
and background settings.

Page Controls the view size of the current page, displays page rulers, guides, switches
between double sided and single sided pages. Also allows you to insert, delete and
navigate through the document pages, and contains multiple master pages support.

Window Displays a set of currently active windows, and allows you to activate any one of
them directly. Also provides options for repositioning open documents on-screen.

Toolbars

DesktopPublisher Pro provides a toolbar manager that allows users to create, customize, sho w, hide,
move, reshape, and delete toolbars. All these operations will be discussed in detail in the
DesktopPublisher Pro in Depth section. 

This section provides you with a short description of the default toolbars and the toolbar opera-
tions and elements that are on your screen when you start DesktopPublisher Pro. This is quite enough
for an initial acquaintance with the product. 

Toolbar windows contain collections of toolbar elements - buttons, pop-up menus, edit boxes and
arrows, which represent various functions, and allow you to edit various settings in DesktopPublisher
Pro. The majority of the toolbar elements in DesktopPublisher Pro are graphic representations of the
functions available in the menu bar , providing easy access to the most common features of
DesktopPublisher Pro. Other elements reflect some dialog boxes settings.

Clicking on a button accesses that button's function, clicking on a pop-up menu accesses a list of
functions available in that pop-up menu. Some toolbar buttons or pop-up menus change document
or even application attributes, while others af fect just a selected section of text, the current para-
graph, or just a selected object. Lastly , there are some toolbar buttons that change the function of
the mouse cursor, allowing you to make changes to a document.

Here, in the FAST OVERVIEW section, we will pay attention to these topics:

• First Glimpse

• Moving toolbars on the screen

• Using toolbar elements

• Tool Palette

5
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First Glimpse

Right after you first launch Mac Publisher Pro, five toolbars are displayed on the computer
screen. Four of them are on the top of the screen, in the area called the Control Dock, and one is
located along the left side of the document window . 

The vertical toolbar is the Tool Palette, it will be discussed separately below . It dif fers from all
the other toolbars in that it looks like a Macintosh utility window , i.e. has the window title, and the
close and resize boxes.

Each toolbar can be moved between the Control Dock area and any other part of the screen, thus
changing its appearance from a frameless window , to the floating utility window look. The names
of the toolbars are displayed on the utility windows’ title bars when the toolbars are outside of the
Control Dock. 

The toolbars contain toolbar elements grouped by their functionality. For example, the Edit tool-
bar contains buttons that represent various functions from the Edit menu. The Text toolbar contains
toolbar elements affecting the current text settings, etc.

Moving toolbars on the screen

DesktopPublisher Pro allows repositioning toolbars on the screen to the locations that may be most
convenient for accomplishing particular tasks. For example, if you need to use the Edit tools often,
you may choose to place the Edit toolbar in the location that is most convenient.

To change a toolbar from one that is anchored in the Control Dock to a floating window, just click
on it with the mouse and drag the toolbar to desired location. While dragging, the toolbar becomes
a rectangle that moves along with the cursor . Releasing the mouse button places the toolbar on the
screen as a floating window shown below:

If you move a toolbar within the Control Dock to a position overlapping another toolbar , it will
be placed at the location and the other toolbar will move to a new position in the Dock. This will
sometimes create a new "tray" for the Control Dock, a new area at the bottom of the Dock for the
toolbars to be located.

6

Desktop Publisher Pro by Cristallight



Using Toolbar elements

Using the toolbar elements is very easy. Toolbar buttons can function either like push buttons, that
means that clicking on them just invokes some action, or like switch buttons which toggles the cur-
rent state of some attribute. For instance, the Undo button on the Edit toolbar will undo and redo
the previous operation, and the Bold button from the Text toolbar reflects the state of this attribute,
and remains pressed when the text insertion point is within the “bolded” text range.

The buttons can be grouped. In some cases this means that functionally they have some traits in
common, like the Undo, Cut, Copy, Paste, and Clear buttons on the Edit toolbar. In other cases
this means that the buttons work like a radio button group, i.e when one button of the group is
pressed, the others depress automatically.

The toolbar elements containing edit fields allow two modes of changing their state. First is by
typing a new value directly into the edit field.

When you type, a new value becomes displayed in a dif ferent color until you complete typing.
Some toolbar elements allow automatic search of possible options as you type. In the Font Name
box shown above, when you type the letter “g”, the value that is automatically found may be “gad-
get”. Typing the second letter “e” narrows the search, and shows the “Geneva” font. You can press
Enter to finish the process of setting a new font.

The second way is by using the correspondent menu button, or little arrows to the right of the edit
field.

Toolbar elements show their descriptions. When you move the cursor over a toolbar element, it
displays a small window with short description of the element’ s functionality:

.
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Tool Palette 

The Tool Palette is a toolbar that is represented as a vertical row of icons, initially located along
the left side of the computer screen. This is the only toolbar that contains buttons unique by their
functionality. Not one of these functions is present anywhere else, either in menus or in dialog
boxes.

It allows object manipulation and creation, and changing the current view size. Clicking and hold-
ing in any other area of the title bar and then moving the mouse allows you to reposition the Palette
to other locations on the desktop, or to the Control Dock. Individual buttons on the palette are acti-
vated by clicking on them. The functions of the individual buttons are described below:

Object Tool

The Object tool is used for activating, repositioning or resizing one or more objects, created with
the other tools, i.e. Text Box, Power Text, Bezier, Bezier Text and Speech Balloon tools, described
later in this section. Activating an object is done by clicking on it, thus making its handles appear .
To reposition the object, click on it and drag to the location you wish. To resize the object, click on
one of its handles and drag. Using modification keys ( Command, Option, Contr ol, see the
KEYBOARD SHORTCUTS section later in this chapter ) places constraints on the object’ s movements
and resizing.

Picture Mover Tool

The Picture Mover tool is used to move pictures inside of their picture boxes. Selecting it from

the Tool Palette changes the cursor to the Hand pointer when it is over an active picture box.
To reposition the picture, click and drag the mouse. 

Rotation Tool

The Rotation tool is used to rotate an object around any point.  Any object in DesktopPublisher Pro
may be rotated by any angle. After selecting the Rotation tool, the pointer changes to a set of

crosshairs centered in a circle when you move it over the page. Click and drag away a short
distance from the pivot point in any convenient direction. 

8
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Zoom Tool

Use the Zoom tool to zoom in on a particular part of the page. Click and hold at the corner of an
area on which you wish to focus. Drag a rectangle over that area and release. The view of the area
becomes the largest view possible in the current window. 

Simple clicks zoom in, and Option-clicks zoom out the view size by predefined amount. You can
change this amount using the Preferences… option from the Edit menu.

Text Tool

The Text tool is used to highlight a segment of text in a text box, or to position the text insertion
point (which allows you to type new text into a text box). Selecting the Text tool changes the point-

er from an Arrow to an I-beam when moved over the text box. Highlighting a text seg-
ment, allows changes to various text attributes such as color, shade, size, font and others. The high-
lighted text segment will have a different color on the screen. The text insertion point defines a posi-
tion at which new text may added into the text box.

Text Box Tool

The Text Box tool is used to create a new text box. A text box is a rectangular region in which text
is placed. To create a text box, click on the Text Box tool, then move the pointer to the location where
you want one corner of the text box to be. The pointer should appear as a set of crosshairs. Click and
hold the mouse button, then drag to the location where you want the opposite corner to be, then
release. The Mac Publisher Pro switches to the Text tool.

Power Text Tool

This tool lets you to place a special text object on your document. Text in this object can have
some special attributes such as auto scaling to fit the text box. 

9
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Graphics Object Creation Tools

The Graphics Object creation tools are used to draw various graphic objects on a document. To
create a Graphics object, click on the corresponding icon, then position the pointer where you want
one of the corners of the object to be placed. Click and hold the mouse button, drag to where you
want to place the opposite corner, and release. The newly created object appears with handles indi-
cating that it is active.

If the Shift key is held down during the creation process, the shape or orientation of the object is
constrained. Rectangle or rounded-corner rectangle boxes are constrained to a square. Ovals are
constrained to a circle. Non-orthogonal line orientation is constrained to 0°, 45° and 90°. 

Speech Balloon Tool

The Speech Balloon tool is used for creation of Speech Balloons, appearing as text inside bal-
loons. There are twelve balloon types in DesktopPublisher Pro. In combination with the di fferent col-
ors, styles, shades applied to both the balloon and the text inside, it provides a wide range of effects
to make your document bright and expressive. To create a balloon with the help of the Speech
Balloon tool, click on it, then move the pointer to the location where you want one corner of the
object frame. Click and hold the mouse button, then drag to the location where you want to place
the opposite corner of it, then release. 

Bezier and Bezier Text Tools

Use the Bezier tool for adding Bezier curve objects to your documents. To create a curve, select
the tool from the Tool Palette. Click in the position where you want to locate the starting point of
the curve, then release the mouse, and drag it to a new position. A curve will be drawn as you move
the cursor. Click and drag the mouse to a new location again. Repeat the process until the curve is
completed, then make a double click with the mouse. The Bezier tool will deactivate then, and the
Object tool will become active.

The Bezier Text tool allows you to display text along Bezier curves. After you define the curve,
as described above, you are able to add text, and change some text attributes, such as font, font size,
color, and shade. 
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Linking and Unlinking Tools

The Linking tool forms a connection between text boxes. Text “flows” between linked boxes as
if they were one continuous region. This flow between linked text boxes is referred to as a “text
chain”. The Unlinking tool is used to break the links between text boxes. 

Equal Tool

The Equal tool is used for making one object the same size as another .

To use the tool, select it from the Tool Palette. The cursor changes to the Equal cursor. Click
on the first object, then on the second object. The second object changes its dimensions to be equal
to those of the first object. 
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Document Window 

When you create a new document or open an existing document, the Document Window associ-
ated with that document appears. 

The Document Window is used to contain the screen representation of one page of the document
you create. The Rulers are located along the left and top sides of the window , and the document is
surrounded by a blank area, known as the Pasteboard, which can be used as a work area while set-
ting up your document, much like a tabletop behind a sheet of paper .

Also, the bottom left side of the Document Window contains some controls that allow easy access
to a particular page of the document, and changing of the view size of the page.
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The document drawing area, or the page, is the printable portion of the document. This is the area
where you place and manipulate objects, which are to be printed later. It also may contain non-print-
able service guide lines: called Mar gin Guides, used for showing page mar gins, and Ruler Guides,
used for aligning objects. 

These guide lines will be discussed in detail in the  DesktopPUBLISHER PRO IN DEPTH section.

The Pasteboard area is the non-printable area around the document drawing area that may be
used for storing objects while creating your page design. When there are a lot of objects to be placed
on a page, sometimes it is dif ficult to position all of them at once exactly in the desired locations.
You may wish to move some of them to the Pasteboard to be used later . Also, since the Pasteboard
is common to all the document pages, moving objects to and from it is one more way to move
objects between pages, in addition to cutting an object from one page, and pasting it to the other . 

The View Size control (located in the bottom left corner of the document window) is used in
changing the view size. There are several predefined view sizes contained in the pop-up menu.

Other controls located in this area are (from left to right):

• Left Master Page control,

• Right Master Page control,

• Previous Page button, 

• Page Number indicator and Go To Page control, and 

• Next Page button

Detailed descriptions of the purposes and functionality of these controls is contained in the
DesktopPUBLISHER PRO IN DEPTH section.
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Tutorial

Introduction

In this section, you will see how the various components available in DesktopPublisher Pro can be
used to create outstanding original documents. You will learn how to:

• create a new document using the Mac Publisher Pro predefined templates, and import text
and picture graphics into the already existing objects

• create a new document from scratch, use the tools available in DesktopPublisher Pro to place
various design elements on your documents, reposition, copy, paste, and change the objects
stacking order on a page

Allow yourself approximately 15 minutes to half an hour to complete each lesson.

The goal of the tutorial is to help you learn the basic concepts, tools, and environment available in
DesktopPublisher Pro and to show you how to use those items to create, build and save documents quick-
ly and easily. 

The section is intended as an introduction to the material and is not intended as comprehensive
instruction in using DesktopPublisher Pro. Detailed descriptions of the various components in
DesktopPublisher Pro are provided later in the manual.

Two lessons are presented. 

Lesson One: Creating a Document from a Predefined Template

The lesson will show you how to:

• Start DesktopPublisher Pro

• Open an existing document template

• Add text to the text box object

• Apply text styles to the text

• Work with a Power Text object

• Add a picture to the picture box object and modify the picture box settings
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In this lesson, we want to make some changes to an existing document loaded from one of the
DesktopPublisher Pro predefined templates.  This lesson covers the simplest and most frequently used
text and picture operations you will use with DesktopPublisher Pro. When combined with LESSON TWO,
“CREATING A DOCUMENT FROM SCRATCH”, showing the work with objects, master pages, Style
Sheets, importing and formatting text, you will be ready to create bright and attractive documents in
a matter of minutes.

Starting the Program

Before we can begin working in DesktopPublisher Pro, we need to start the program. Move to the
DesktopPublisher Pro folder on your hard disk. Double-click on the DesktopPublisher Pro application icon
to start the application. After starting the application, the DesktopPublisher Pro logo will appear momen-
tarily and the menu bar will change to show the menu for DesktopPublisher Pro. The Title Bar will dis-
play the application name “DesktopPublisher Pro.”

The first dialog box that appears is the “New Open Document” dialog box.

It presents you with three options. Please choose the second one– Create Document fr om
Template. Clicking on the phrase Create Document from Template, or the corresponding button,
makes the selection. Press OK to confirm your choice.

Open an Existing Document Template

To be able to begin work on the predefined document template you must select and open it. 

Once DesktopPublisher Pro is started, and the Create Document from Template choice is made, you
are presented with the “Select Template” dialog box. It contains the Template List, which displays,
sorted by category, all the predefined templates that are distributed with DesktopPublisher Pro. The dia-
log box also contains the Preview area, which shows the preview of the current template and allows
you to select text and picture boxes to fill them with contents; the Navigation controls are located
right under the Preview area. 
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Open the Newsletters folder, and select the NewsLetter 1 document template. This causes a pre-
view of the template to be displayed in the Preview area.

At this stage we will want to fill all the text and picture boxes with appropriate contents. The but-
tons Place Text and Place Graphics will help us in implementing this task. Let’s start with the text
box that contains the word “Text” in it. To fill it, follow these steps:

Click on the Preview area. This will replace the picture preview of the document template with
the actual document, allowing you to select objects in it. 
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Click on the text box object. Since it is a Text Box object, this activates the Place Text button.
Click on the button. You will be presented with the “Open” dialog box for importing of the text file
containing the desired text for this text box.

Navigate to the  Tutorial folde r, which is in the DesktopPublisher Pro folde r, and select the file 
“community gym text”. Click Open. The text fills the text box.

Now select the “photo” object in the lower-right corner of the template. Since it is a picture box,
the Place Graphics button is activated. Click on the button to activate the “Open” dialog box.
Navigate to the DesktopPublisher Pro CD-ROM and open the Graphics Libraries folder. Inside this fold-
er you will find a number of subfolders; open the subfolder named “Sports Folks” and click on the
graphic named “SMEN012.pict.” Click the Open button to place the graphic in the Graphics Box.

Click on the Done button in the “Open Template” dialog box to complete the document creation.
The document is immediately displayed, and you can view the results:

In the remainder of this lesson you will need to modify the Headline then format the text.
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Modify the Existing Headline

Select the Object tool from the Tool Palette and double click on the Headline object at the
top of the page. This will display the “Text Effects” dialog box:

Enter the text “Tired of Being A” instead of the word Headline in the upper edit box and the text
“98-Pound Weakling?” in the second edit box. Then click on the button with the right arrow on it
located under the preview area of the dialog box to select the next pre-set Headline Style; keep click-
ing until the 11th style (of 25) is selected. Select the Center alignment from the Alignment pop-up
menu in the right part of the dialog box. Your “Text Effects” dialog box should now look like this:

Click the OK button to make your changes.
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Your document should now look something like this:

Next you will need to format the text.
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Formatting the Text

Next you will need to format the text. The text as imported is accurate and therefore does not need
to be edited for content, but we want to use the “questions” asked in the text as section headlines,
making them larger and darker than the rest of the text to stand out and draw people’ s attention.

First, select the first question in the text, reading:”What is the Community Fitness Program?” 

To select a section of text, you must use the Text tool found in the Tool Palette. Click on the
Text tool in the Palette and move your cursor to the beginning of the sentence “What is the
Community Fitness Program?” Click and hold the mouse button, then drag the mouse cursor to the
end of the sentence and release the mouse button. The text will now be highlighted, indicating that
it has been selected.

Now you will need to change the size of the text. To really make the questions stand out, as well
as make use of as much of the space as possible, you will be changing the text to 18-point size.
Move the mouse cursor over the Font Size box in the Text toolbar; currently this box should be dis-
playing a number twelve.

Click on the arrow button next to the Font Size box to display a menu of available font sizes;
select the size 18 from the pop-up menu; you will see the text change size in the Document Window.

Next you will need to choose the Bold style from the Text tool bar. With the text still selected,
click on the Bold Style button.

You will see the change applied to the text.
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Select the next question, “When and Where?” and make the same changes by choosing 18 points
from the Font Size box and then clicking on the Bold Style button, both in the Text toolbar.

Now do the same for the following sentences: “Who can Attend?” “What Do I Need To Bring?”
“How Much Does It Cost?”

Finally, we want to move all the text following the answer to “Who can Attend” to the second
column. The two columns have been Linked, meaning that text flows from the left column into the
right column automatically as it runs out of room in the right column.

Make sure that the Text tool is selected and move the mouse cursor to the end of the para-
graph ending “surrounding communities may attend.” Click the mouse button to move the Text
Insertion Point(the point at which text is modified) to the end of the paragraph. 

Now press the Return key on your keyboard repeatedly until the large sentence “What Do I Need
To Bring?” moves to the top of the right-hand column.

Finally, you will need to delete the lar ge word “TEXT” at the end of the second column.

Select the Text tool  from the Tool Palette and move the cursor over the word “TEXT” in the
right-hand column. Double-click the mouse button. The word should become highlighted. Press the
DELETE key on your keyboard to delete the word.
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That’s all. Congratulations, you have just finished this lesson of the  Desktop Publisher Pro Tutorial.
The resulting page should look like the picture below:
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Lesson Two: Creating a Document from Scratch

Welcome to the DesktopPublisher Pro second lesson. In this lesson, you will learn to use many of the
features of this powerful desktop publishing tool.

For the purposes of this lesson, you will be laying out the first page of a n imaginary edition of
Jack London’s classic, Call of the Wild.The layout we intend allows us to demonstrate several basic
and advanced features of DesktopPublisher Pro 

To begin with, let’s create a new document. If DesktopPublisher Pro is not running yet, start it by dou-
ble-clicking on the application icon; once DesktopPublisher Pro is running, choose New… from the File
menu to create a new document. A dialog box will appear asking whether you want to create a new
document from scratch or use a template. For the purposes of this tutorial, please leave the selection
as Create a New Document from Scratch and click the OK button.

The following dialog box will appear:

This is the "New Document" dialog box. Here you choose many important settings when you cre-
ate a new document. You can set the size of the paper, the number of column guides that will be dis-
played, and the margins between the edge of the paper and the first items that appear on the page,
as well as several other options. 

For this tutorial, please make the dialog box look as it does in the illustration above – i.e. a US
letter-sized piece of paper , Portrait (vertical) orientation, with 0.5 - inch mar gins, starting on page
#:1, with Automatic Text Box, no Double-sided Pages and having three columns.
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Once you have made the selections for the tutorial, click the OK button to create your new doc-
ument. A new Blank document will appear . What you are seeing is the Document Window sur-
rounded by various tool palettes and tool bars.

On the document page you can see the margins as a series of dark blue lines. These margins indi-
cate the edges of the various columns you set up when you created the document. These margins
will not print, and are used to visually set up the document according to your specifications. You
may place any object at any point on a document you wish, but the mar gins give you useful guide-
lines for laying out your document. The tutorial document was created with half-inch margins at the
sides and top with three columns which are not separated. 

Also, we will place a Ruler Guide line on our document, to help position the objects on the page
later. Move the mouse to the horizontal screen ruler on the top of the Document Window, click on
it, and drag the mouse down the page. Position the ruler one and a half inches below the top mar-
gin guide line,at the 2-inch mark on the side Ruler. In the following diagram, the three columns and
the ruler guide are shown. 
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All the guide lines are under the Text Boxes on the page, so only the uncovered parts of them are
visible. This is because the Guides in Back check box in the “Preferences” dialog box is checked.
If we changed this setting, the guides would be displayed over all the other objects on the page.

Creating Style Sheets

Next we are going to set up some Style Sheets. Style Sheets are a convenient way to save for-
matting information for different kinds of paragraphs on a page. For example, headers are usually a
little bit lar ger than other text on the page and are often in bold typeface. When you create a
"Header" Style Sheet for a document, you can quickly format any section headers as lar ger text in
a bold typeface. We will make some Style Sheets to prepare for the document we are going to cre-
ate in this tutorial. (Please note that we will not be exploring all of the options associated with Style
Sheets in this tutorial. For detailed descriptions of every option, please see the STYLE SHEETS sec-
tion of this manual.)

Select Edit Style Sheets… from the Edit menu in the menu bar . The “Style Sheets” dialog box
will be displayed. When you create a new document, there is only one style created - Normal. This
is the default style for any new paragraph in the document. We will start by editing the Normal Style
Sheet to choose what sort of appearance most of the text will have. 

25

Desktop Publisher Pro by Cristallight



Click once on the name Normal in the list and click on the Edit button. The “Edit Style” dialog
box will be displayed:

At the top of this dialog box is a field where you can edit the name of the Style Sheet. For this
style, we will leave the name as “Normal.”

Click on the Paragraph button to display the “Paragraph Info” dialog box; here you can choose
various options for formatting the lines of text of any paragraph that will be displayed in the Normal
style.

For the purposes of this tutorial, please set the Alignment to Justify, and the First Line value to
one eighth of an inch (.125”). This will shift the first line of each paragraph by the specified amount
(.125”). 

We will change the the Space Before and Space After values also, so that text formatted with
this Style Sheet will be separated by these spaces from the rest of the text. Enter the value “.055” in
both the Space Before and Space After fields of the dialog box.

All the other options should be left at their default settings. 

Click OK to return to the “Edit Style” dialog box, then click OK in this dialog box to return to
the “Style Sheets” dialog box – we've made all the changes we want to to the Normal style.
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Now click on the New button in the “Style Sheets” dialog box to create a new style. You will see
the “New Style” dialog box, similar to the “Edit Style” dialog box. This time, however, the Style
Name field will be empty. Type the word “Header” in this box to name the style Header. Now click
on the Character button to change the character attributes for the Header style.

For the Header style, we will still be using the Helvetica font, but we want to make the font big-
ger so it stands out more. Choose the size 14 from the Size pop-up menu.

Now we want to make the text Bold so it will stand out even more. At the right side of this dia-
log box you will see a number of dif ferent Style choices you can make. Please click on the Bold
item in the list to change the text to a thicker shape. In the Preview Window at the top of the dia-
log box you will see a preview of the change. 

Finally, we will change the character color to Blue. Now the dialog box should look something
like this:

Click the OK button to save your changes to the Header character style. You will return to the
“Edit Style” dialog box.
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Now click on the Paragraph button to change the attributes of the paragraph for the Header
style. The “Paragraph Information” dialog box will be displayed.

Here you can change attributes af fecting the overall shape of the paragraph. For the purposes of
the tutorial, please leave the Alignment as Left by verifying that Left is selected in the Alignment
pop-up menu. 

We won’t change the First Line attribute this time, but will add .125 inches to the Space Before
and Space After fields. 

Also, check the Drop Caps check box. This feature causes the first letter of the paragraph to be
displayed in a lar ger size then the font size used for the rest of the paragraph. Type 3 into the
Number of Lines edit box right under the Drop Caps check box. This will make the initial letter
to be as tall as three lines of text.

Now click the OK button to save your changes; you will return to the “Edit Style” dialog box.
Now click OK again to finish creating the Header style.

Once you have finished creating the Header style, you can click the OK buttons in all the dialog
boxes you see until you return to your document. 
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Changing an Existing Text Box

For the next portion of this tutorial, we will change the size of the Text Boxes that were auto-
matically created when we created the document.

Select the Object Tool from the Tool Palette and move the mouse cursor over your docu-
ment. When the document was created, three Text Boxes were added, one in each column. Click on
the leftmost Text Box to activate it; when an object is activated, a series of small rectangular “han-
dles” appear around the Text Box. One handle is located at each corner of the object and one in the
middle of each side. Handles are used to change the size and shape of an object. The following
example illustrates a small object with handles around its perimeter .

Move the mouse cursor over the handle in the center of the top line of the leftmost column Text
Box. The cursor will change to the Resize/Reshape cursor , which looks like a pointing hand. Click
and hold the mouse button.

Now drag the mouse downwards, still holding the mouse button, until the top of the Text Box is
even with the Ruler Guide we added at the beginning of this lesson (i.e. the top of the text box is
now even with the 2-inch mark on the left-side ruler); if Snap to Guides is currently checked in the
Window menu, then the Text Box will “snap” to the line, making it easier to precisely place the top
of the Text Box at the 2-inch mark marked by the rfuler guide.

Now do the same for the other two Text Boxes on the page, making all three even with their tops
at the 2-inch mark as measured by the Document Rulers.
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Creating a New Text Box and Adding Text

Now we want to add the book title to the page. We will be adding a Text Box to the top of the
page into which we will add the title and author of the book; then we will change the color of the
Text Box and the text.

Click on the Text Box tool in the Tool Palette. Move the cursor over the upper left corner of
your document, right at the junction of the blue lines inside of the document. The cursor will change
to look like a crosshairs. Click and hold the mouse button. Drag the mouse down and to the right.
You will see a dotted-line box following your cursor from the point at which you clicked; this means
that a new Text Box is being added, the dotted-line box indicating the size, shape, and position the
Text Box will take when you release the mouse button.

Release the mouse button to finish drawing the Text Box at the intersection of the right mar gin
guide line, and the ruler guide line we placed on our page at the beginning of the lesson. 

The Text tool will automatically be selected, and you can begin typing text in the new Text
Box. Type “White Fang” then press the Return key on your keyboard to begin a new line. Type
“Jack London” in the second line.

Now we wish to format the text in the Text Box. Currently , all the text is formatted using the
Normal Style Sheet, as is all new text in a document.

Formatting Text

Select the text “White Fang” in the Text Box. (Move the cursor to the beginning of the word
“White” and click and hold the mouse button; now drag the mouse to the end of the word “Fang”
and release the mouse button. The words “White Fang” will be highlighted.

First we want to change the text to 48-point size; move the mouse cursor over the Font Size box
in the Text toolbar; currently this box should be displaying a number twelve.
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Click on the arrow button next to the Font Size box to display a menu of available font sizes;
select the size 48 from the pop-up menu. You will see the text change size in the Document Window.

Next you will need to choose the Bold style from the Text tool bar. With the text still selected,
click on the Bold Style button.

You will see the change applied to the text.

Finally, we want to make the text Center aligned. Click on the Center Alignment button in the
Text tool bar to align the text to the center of the Text Box.

The text should now look something like the following:

Next we want to format the author’s name. Make the text “Jack London” Bold, Center Aligned,
and 14-point size; the appropriate sections of the Text toolbar should look as following:

The Text Box should look like this:
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Changing the Color of Text Boxes and Text

Now we want to change the background color of the Text Box to be Black, making it really stand
out compared to the rest of the page. (We’ll also change the text to white to make it show up against
the black Text Box.)

Select the Object tool from the Tool Palette and click once on the Text Box containing the
book title to select it. Now move your mouse cursor over the Graphics item in the menu bar; click
and hold the mouse button. Move the mouse cursor down to the Fill Color item in the menu to dis-
play the Fill Color submenu. Select the Black item from the Fill Color submenu to change the Text
Box to black. Now your Text Box should look like a lar ge black rectangle at the top of the page.

To change the text color, select the Text tool from the Tool Palette. Click once on the black
Text Box to place the Text Insertion Point inside the Text Box. The Text Box will become white,
allowing you to easily edit the text inside it. Now choose Select All from the Edit menu in the menu
bar; this will select all the text in the text box. To make the text white, select the White option from
the Color submenu of the Text menu in the menu bar.

Now the Text Box should look something like this:

Importing Text

Next we will be importing text to add to the three original Text Boxes created with the document.
We added imported text to the document created in LESSON ONE of this Tutorial, but did so via the
Template functions. In this instance, we will be importing text directly into the Text Boxes of the
document.

Select the Text tool from the Tool Palette and click on the leftmost column Text Box to acti-
vate it and place the Text Insertion Point in the Text Box. Now select Import Text… from the File
menu in the menu bar . A standard Macintosh “Open File” dialog box will appear . Navigate to the
Tutorial folder (if it is not already active) and select the file “ White Fang text.” Now click on the
Open button to import the text.
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The text will appear across the columns of your document; when a document is created with mul-
tiple columns, the Text Boxes in these columns will automatically be linked to one another from left-
most to rightmost provided that Automatic Text Box was checked when you created the document. 

Formatting Imported Text

All the text imported into the document is automatically formatted with the Normal Style Sheet.
For the most part, this is exactly as we want it to be.

However, we wish to use the Header Style Sheet we created earlier to format the first sentence
of the text, the sentence reading: “CHAPTER I - THE TRAIL OF THE MEAT.”

Click on the Text tool in the Tool Palette then move the cursor to the beginning of the word
“CHAPTER” and click and hold the mouse button; now drag the mouse to the end of the word
“MEAT” and release the mouse button. The words “CHAPTER I - THE TRAIL OF THE MEAT”
will be highlighted.

Now we want to change the text to the Header Style Sheet; move the mouse cursor over the Style
Sheets box in the Text toolbar; currently this box should be displaying the Normal Style. Click on
the arrow button next to the Style Sheets box to display a menu of available Style Sheets; select the
Header Style Sheet from the pop-up menu. 

You will see the text change in the Document Window.
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Your document should now look like this:
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Adding Graphics

Next you need to add graphics to the document. We have provided graphics for you to import for
this tutorial; these are located in the " Tutorial" folder installed along with DesktopPublisher Pro.

Select Import Graphics from the File menu. A standard Macintosh “Open File” dialog box will
appear. Click on the file white_fang_pict1 inside the Tutorial folder and click the Open button. 

The graphic will not be immediately imported. 

Your cursor will instead change to the “Pic” cursor  , letting you know that DesktopPublisher
Pro is ready to place your imported graphic. To place the graphic, move the cursor to the top-left
corner of the middle text column. Click and hold the mouse button. Now drag the mouse down and
to the right, drawing a dotted-line box to indicate the size and shape the graphic will take when it is
imported. Draw the rectangular box until it extends all the way to the right side of the middle col-
umn and down to a point about 4.75 inches down the page (as measured by the Ruler along the left
side of your document). Now release the mouse button to finish importing the graphic. 

Since the picture is not of the same size as the box we drew for it, the image will not fit inside
the box. 
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To position the graphic better within its box, select the Object tool from the Tool Palette and
click on the box you just added. Now select Object Info from the Object menu in the menu bar.

The “Picture Information” dialog box will be displayed. Here you can change various attributes
of any selected object or objects in DesktopPublisher Pro. Attributes such as object size and position
can be precisely adjusted, and various display options can be modified. For now , please make sure
that the Scale with Box checkbox is unchecked, and the height,width, offset, and scale attributes of
the box is the same as in the dialog box above.

Click OK to apply your changes. The graphic should now look something like the following:
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Next you need to add the final graphic to the document. Select Import Graphics again from the
File menu. The “Open File” dialog box will appear . Click on the file white_fang_pict2 inside the
Tutorial folder and click the Open button. The graphic will not be immediately imported. 

Your cursor will once again change to the “Pic” cursor  and DesktopPublisher Pro is ready to
place your imported graphic. Move the cursor to the bottom-left corner of the middle text column.
Click and hold the mouse button. Now drag the mouse up and to the right, drawing a dotted-line box
to indicate the size and shape the graphic will take when it is imported. Draw the rectangular box
until it extends all the way to the right side of the middle column and up to a point about at the 8.5-
inch mark on the vertical ruler along the left side of your document. Now release the mouse button
to finish importing the graphic. 

The graphic will be imported:

This graphic is the correct size and shape for the box we drew , but you may wish to verify that
the size and position of the box are correct. To do so, you may once again open the “Picture
Information” dialog box.

To access the “Picture Information” dialog box, select the Object tool from the Tool Palette
and click on the box you just added. Now select Object Info from the Object menu in the menu
bar.
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The “Picture Information” dialog box will be displayed. Please make sure that settings in your
“Picture Information” dialog box match the settings in the dialog box pictured above.
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Congratulations! You have finished LESSON 2! Your document should know look like this:

The remainder of this book details the various features of DesktopPublisher Pro. Start creating your
own documents, and when you have trouble, you can refer to the appropriate section!

Happy creating!
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Desktop Publisher Pro in Depth

Program Overview

Welcome to DesktopPublisher Pro, a comprehensive application allowing you to seamlessly integrate
text and graphics and other design elements to create sophisticated documents for business and
home. It is designed to provide you with all the features of major “power -house” desktop publish-
ing programs without the accompanying complexity and cost.

With DesktopPublisher Pro you are able to:

• create a new document either from scratch or from many predefined templates distributed
along with DesktopPublisher Pro. The template types are: Brochure, Business Card, Certificate,
Envelope, Facsimile, Flyer , Greeting Card, Invitation, Invoice, Letter Head, Memo, and
Newsletter,

• import graphics in various graphic formats into your documents, allowing resizing and other
transformations without any loss of quality,

• print all, even or odd pages of your documents with crop marks and color separations,

• Preview the printer output using the ColorSync preview option,

• place any text on to your documents and add special ef fects, such as stretching, outlining,
filling with blend, and shadowing,

• use powerful features to find/replace text and style,

• link Text Boxes, creating “text chains”,

• create, edit and use style sheets,

• add, edit and delete colors used in your documents,

• add and manipulate objects on your documents, aligning them and changing their stacking
order on a page, 

• add special “Speech Balloon” design elements,

• apply colors to virtually any design elements foreground and background, draw various
graphic elements in any width, color or pattern, 

• import graphics created with other applications,

• change the view scale, easily navigate through the document pages, add and delete pages,

• use powerful Master Pages support, 

• use DesktopPublisher Pro spell checking, thesaurus, rhyming capabilities, text hyphenation, and
more.
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The text editor allows you to produce text in dif ferent fonts, colors, styles, and sizes. With it you
have the ability to control line spacing (leading) and alignment of text on the page. Use the text edi-
tor to produce and manipulate Text Boxes of different sizes and orientations.

Power Text objects allow you to add special effects. Text in such objects fills the entire Text Box,
expanding or contracting as necessary, but always extending to the outermost boundaries of the box.
The more text you enter , the more compressed the letters will be in the power text block. Special
effects can be applied to your power text. The text can be squeezed, arched, slanted, stretched, col-
ored, and otherwise manipulated.

Many graphic images are provided in the DesktopPublisher Pro graphics libraries, but graphics
objects from many sources, in various dif ferent graphic formats, can be imported into your docu-
ment. DesktopPublisher Pro relies on the Macintosh  Translation Manager capabilities allowing you to
translate up to thirty graphic formats. If the  Translation Manager is absent, DesktopPublisher Pro sup-
ports the import of TIFF, PICT, EPS, QuickTime, PNTG and GIF images. You can also import and
export graphics to and from other applications using the Clipboard.

Exporting your document is possible either as a plain text document, or an HTML file. This
allows you to open the exported document with any web browser .

You can rotate any object to any angle.

DesktopPublisher Pro provides a single application with the ability to create documents to satisfy any
printing need.

Note: the appearance of the DesktopPublisher Pro interface elements may di ffer from the pictures
found in this manual.  The program allows you to switch between the DesktopPublisher Pro default
appearance, the Apple Platinum appearance, and other appearances available on your computer by
pressing Command + Option + Control + ‘0’ (zero). A dialog box will appear asking which appear-
ance you wish to use.

Toolbars

Toolbars are collections of "buttons" and pop-up menus which represent various functions in
DesktopPublisher Pro. Clicking on a button accesses that button's function for use, clicking on a pop-
up menu accesses a list of functions available in the pop-up menu. Some buttons or menus change
everything in a document, some buttons or menus change the selected section of text, and some but-
tons or menus change the function of the mouse cursor , allowing you to make changes to a docu-
ment.

Most of the toolbar elements in DesktopPublisher Pro are graphic representations of the functions
available in the menu bar . The elements provide easy access to the most common features of
DesktopPublisher Pro.
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The following are all the toolbars available in DesktopPublisher Pro:

• File

• Edit

• Object

• Text

• Content

• Graphics

• Page

• Tool Palette

You may choose to display one or all of the toolbars at any time, although you may find that hav-
ing all of the toolbars open at once clutters your computer screen. By default, when you first open
Mac Publisher Pro, you will see the most commonly-used toolbars open. The less-often-used tool-
bars are not displayed, but you may easily change the toolbar displays. You may also choose to have
the toolbars "float" above the document window , allowing you to move them to any convenient
location you choose. Toolbars can later be returned to the control dock at the top of the screen, the
area where the toolbars are neatly or ganized into rows.

Creating and Deleting a Toolbar

Creating Toolbars: You are able to create new toolbars using the Edit Toolbars dialog box. This
allows you to create your own custom toolbars that will contain only the functions you most often
access.

Open the Edit Toolbars… dialog box by choosing Edit Toolbars… from the Edit menu in the
menu bar. 

Click on the New button to create a new toolbar . After typing in a name for the new toolbar , a
new floating toolbar will be created. 
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The next step is to select the necessary toolbar elements. Clicking on the Custom button will dis-
play the Customize dialog box.

Here you can access buttons for nearly all the di fferent functions available in DesktopPublisher Pro.
A list of function types appears on the left side of the dialog box. Click on any item in the list to dis-
play the toolbar elements available within that category of functions. The description of a toolbar
item functionality is displayed on the bottom of the dialog box when you place the mouse cursor
over the item.

Simply click and drag a button onto the blank toolbar to add it to the toolbar . Drag a button of f
of the toolbar to remove it from the toolbar . 

You may switch between function groups at will until you have added and subtracted as many
buttons as you wish. Keep in mind that a very large toolbar will cover much of the screen, so adding
as many buttons as possible may not be the best course in all instances. Once you have added all the
buttons you wish to the new toolbar , you may want to give the toolbar a name in the field provid-
ed, or change it, if you already gave a name to the toolbar . Click OK to finish creating the toolbar.

Deleting Toolbars: You may permanently remove any toolbar by using the Edit Toolbars… dia-
log box. Open this dialog box by choosing Edit Toolbars… from the Edit menu in the menu bar .
Click on the toolbar name you wish to delete in the list of toolbars at the left side of the dialog box,
then click on the Delete button. The toolbar is deleted from the list.
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Customizing Toolbars

When you first start DesktopPublisher Pro, the File, Edit, Object, and  Text toolbars are displayed in
the Control Dock at the top of the screen and the Tool Palette is "floating" at the left side of the
screen. 

Floating toolbars, such as the Tool Palette, function much like a standard Macintosh window ,
allowing you move, reshape, "windowshade," and close them. Toolbars in the Control Dock can also
be moved around in the Dock, and they can be "picked up" and moved around the screen to become
floating toolbars, like the Edit toolbar shown below.

Finally, toolbars may be hidden, shown, and customized to display any imaginable combination
of buttons representing the functions available in DesktopPublisher Pro using the  Edit Toolbars…
option from the Edit menu.

How to Move Toolbars in the Control Dock: To move a toolbar around in the Control Dock, move
the mouse cursor over the toolbar in the Dock. Click and hold the mouse button on any place in the
toolbar free from toolbar elements. A gray box will appear around the interior of the toolbar , indi-
cating that the toolbar is ready to be moved. Move the cursor to the position in the dock you wish
the toolbar to appear. The gray box will follow the cursor, indicating the toolbar position should you
release the mouse button. Release the mouse button to finish moving the toolbar . Note that if you
move a toolbar to a position overlapping another toolbar , it will be placed at that location and the
other toolbar will move to a new position in the Dock. This will sometimes create a new "tray" for
the Control Dock, a new area at the bottom of the Dock for the toolbars to be located. As this hap-
pens, your Document Window will move downward to give the Control Dock more room. 

The second way to dock a floating toolbaris just to double click on any place in the toolbar free
from toolbar elements. The toolbar will automatically find a free space in the Dock, and will be
moved there.

How to “float" Toolbars: Toolbars can be removed from the dock and changed into floating tool-
bars. To accomplish this, move the mouse cursor over the toolbar in the Dock. Click and hold the
mouse button; a gray box will appear around the interior of the toolbar , indicating that the toolbar
is ready to be moved. Move the cursor to the position away from the Control Dock you wish the
toolbar to appear; the gray box will follow the cursor , indicating the toolbar position should you
release the mouse button. The toolbar will now be "floating" above the document window .
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The second way to "float" an anchored toolbaris to double click on any place in the toolbar free
from toolbar elements. The toolbar will be moved out of the Control Dock.

You can hide and show toolbarsby checking and unchecking the appropriate check boxes in the
toolbars list of the Edit Toolbars… dialog box. You can also Hide a toolbar by just clicking on the
"close" button in the upper -left corner of the toolbar , just as you would with any other window on
a Macintosh.

To reshape a floating toolbar, move your mouse cursor over the Resize Tab in the lower right cor-
ner of the toolbar . Click and hold the mouse button. A gray box will appear around the interior of
the toolbar, indicating that the toolbar is ready to be reshaped. Now move the cursor in the direction
you desire to reshape the toolbar. As you move the mouse cursor, the gray box will change to show
the shape that the toolbar will take when you release the mouse button. Please note that
DesktopPublisher Pro will try to keep the most efficient use of space possible for every toolbar. As you
move the mouse cursor, the toolbar will not reshape randomly, but will "snap" from efficient shape
to efficient shape. 

Toolbar Elements

The Toolbar Elements used in Mac Publisher Pro are:

• Toolbar buttons contain icons which represent their functionality

• Arrow Edit boxes contain a value that is easily changed with the help of the little arrows
to the right of the edit field

• Pop-up Edit boxes allow selection of a new value from the corresponding pop-up menu as
well as typing it directly into the edit field

• Pop-up panes used for representing color , pattern and style choices, consisting of a pane
with a pop-up button to the right

All the toolbar elements contained in a toolbar can be reordered in the toolbar , removed from it,
and some of them, such as Pop-up Edits, can be resized. 

To reorder the toolbar elements in a toolbar or delete a toolbar element from a toolbar , either use
the Customize option from the Edit Toolbars… dialog box, or hold down the Command key–the
cursor will change to the drag cursor; drag the desired toolbar element with the mouse to the desired
location (dragg the button or element “of f” the toolbar to delete it). Addition of toolbar elements is
possible only from the Customize dialog box.
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To resize a Pop-up Edit element, press the Command key, and move the mouse to the right side
of the element. When the cursor changes to the resize cursor (two vertical bars with sideways-point-
ing arrows), click and drag the mouse to make the element smaller or lar ger.

Using toolbar elements is very easy; toolbar buttons can function either like push buttons, which
means that clicking on them just invokes the appropriate action, or like switch (toggle) buttons. In
the latter case they reflect the current state of an attribute. The Undo button on the Edit toolbar
undoes the previous operation, acting like push button, and the Bold button from the Text toolbar
reflects the state of this attribute being either depressed, or pressed. It remains “pressed” when the
text insertion point is within the “bolded” text range.

The buttons can be grouped. In some cases this means that their functionality has traits in com-
mon, like the Undo, Cut Copy, Paste, and Clear buttons on the Edit toolbar. In the other cases this
means that the buttons work like a radio button group, i.e when one button of the group is pressed,
the others depress automatically.

Toolbar elements show their descriptions when the Show Hints check box in the Edit Toolbars…
dialog box is checked. When you move the cursor over a toolbar element, it displays a small win-
dow with a short description of the element’ s function.

.

To switch off the toolbar description option, uncheck the Show Hints check box.

The toolbar elements containing edit fields allow two methods of modification. The first is typ-
ing a new value directly into the edit field.

When you type, the value is displayed in a dif ferent color until you finish typing. Some toolbar
elements allow an automatic search of possible options as you type. In the Font Name box shown
above, when you type the letter “g”, the value that is automatically found is “gadget”. Typing the
second letter “e” narrows the search, and shows “Geneva” font. You can press Enter to complete
the process of setting a new font.
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The second method is to use the corresponding menu button, and the little arrows to the right of
the edit field.

Tool Palette 

The Tool Palette is a toolbar that initially is represented as a vertical row of icons. When the pro-
gram is started for the first time, it is located along the left side of the computer screen. This is the
only toolbar that contains buttons unique in their functions. None of these functions is present any-
where else, either in the DesktopPublisher Pro menus or in the dialog boxes.

The Tool Palette allows object manipulation and creation, and changes to the current view size.
Clicking and holding in any other area of the title bar , and then moving the mouse, allows you to
reposition the Palette to other locations on the desktop and the Control Dock. Individual buttons on
the palette are activated by clicking on them. Individual button functions are described below:

Object Tool

The Object tool is used to activate one or more objects and to reposition them. An object is active
when it is first created, and can also be activated by clicking on it. The active object is indicated by
the presence of handles which are used to resize the object. An object remains active until you click
outside of it. 

Multiple objects can be activated in two ways. First, hold the Shift key and click on inactive
objects. Shift-click on active objects to remove them from a multiple selection. Second, click out-
side of an object and drag the mouse. When the area marked in this way overlaps inactive objects,
they are added to the group selection.

To move an object, it must first be active. The pointer shape changes from the Arrow into the
Cross pointer when it is over an active object. Click and drag the mouse to move the object else-
where. An outline of the object is displayed during the drag.
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Picture Mover Tool

The Picture Mover tool is used to move pictures inside of their Picture Boxes. 

Selecting it from the Tool Palette changes the cursor to the Hand pointer when it is over an
active Picture Box. To reposition the picture, click and drag the mouse. You can also move the pic-
ture inside its box with the Object tool – press the Option key, click on the picture and drag.

Rotation Tool

The Rotation tool is used to rotate any object to any angle centered around any point. 

To use the Rotation tool, first make the object active. Click on the Rotation tool and then move
the pointer to the location on the page about which you want to rotate the object (the pivot point). 

Note that the pointer changes to a set of crosshairs centered in a circle when you move it
over the page. Click and drag away a short distance from the pivot point in any convenient direc-
tion. Note that the pivot point is indicated by the crosshairs while the pointer changes to an arrow .
A line is displayed between the pivot point and the current mouse location. This line acts a a refer-
ence to the original orientation of the object.

As you move the pointer around the pivot point, the line, and the outline of the object rotates.
When you have placed the object in the desired orientation, release the mouse button. 

If the Shift key is held down while rotating an object, the movement is constrained to 45° incre-
ments. Release the Shift key during rotation to permit full movement. 

Zoom Tool

The Zoom tool is used to zoom in on a particular part of the page. Click and hold on one of the
corners of a region that you wish to focus on. Then drag a rectangle over that area and release. The
page view is scaled so that region now occupies the lar gest area possible in the current window.

To zoom out, hold the Option key and click. All sequential clicks with the Zoom tool change the
view scale as specified in Preferences (originally set to 25%). The current amount of a document
view scale is displayed on the bottom of the document window , and on the Page toolbar . You can
arbitrarily change it by simple editing of the value in it.

The Zoom tool stays selected until you change to another tool. 
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Text Tool

The Text tool is used to highlight a segment of text in a Text Box, or to position the text inser-
tion point (which allows you to type new text into a Text Box). Selecting the Text tool changes the

pointer from an Arrow to an I-beam when moved over the Text Box.. Highlighting a text
segment allows changes to various text attributes such as color, shade, size, font and others. The text
insertion point defines a position from which new text is added into the Text Box.

To highlight a text segment, click and hold the mouse button at one end of the text segment and
drag to the other end. To position the text insertion point, move the pointer (I-beam) to the location
at which you want to enter new text and click once. The text insertion point is indicated by a verti-
cal bar.

Text Box Tool

The Text Box tool is used to create a new Text Box. A Text Box is a rectangular region in which
text is placed. To create a Text Box, click on the Text Box tool, then move the pointer to the location
where you want one corner of the Text Box to be located. The pointer should appear as a set of
crosshairs. Click and hold the mouse button, then drag to the location where you want the opposite
corner be, then release. Lines mark the boundary of the newly created Text Box, and handles on those
lines indicate that the  Text Box is active. Note that DesktopPublisher Pro switches to the  Text tool,
changes the pointer to an I-beam and places it in the upper left corner of the newly created Text Box.
This is done so that you can start typing in text immediately .

Power Text Tool 

This tool lets you to place power text objects on your document. They allow you to present text
in some special forms and add color and shade ef fects. 

The power text fills the entire Text Box, expanding or contracting as necessary , but always
extending to the outermost boundaries of the box. 

The more text you enter, the more compressed the letters will be in the text block. If your text is
too compressed, resize the power text object wider . Special ef fects can be applied to your power
text. The text can be squeezed, arched, slanted, stretched, colored, and otherwise manipulated.

To create the object, select the tool from the Tool Palette, then move the pointer to the location
where you want one corner of the object to be placed. Click and hold the mouse button, then drag
to the location where you want the opposite corner be located, then release. 
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The Text Effects dialog box will immediately be displayed. To modify the text, select the font,
the shape, and the justification you want. On the left side of the Power Text dialog, a preview of cus-
tom effects is available for use. 

Note: Justify options are only available when two lines of text are entered.

A custom style effect button can be used to create a new custom ef fect. Outlines, fills and shad-
ows can be added or changed along with the color for each element. Click on the Custom button to
display the Character Ef fects dialog. panels for changing attributes of character outlines, interior ,
shadow, and background are there. 

In the character outline: Use the Style option to select a character outline. Choose from Plain,
Thin, Thick, and Highlight. 

In the Character Interior: Use the Fill option to select fill effects for the character interior. Your
options are Solid, Blend Across, Blend Down, Double Blend, and Radiant.

In the Shadow section of the dialog: Use the Style option to add a variety of shadows. Choose
from No Shadow, Drop Shadow, Block Shadow, and Silhouette. Position options are available for
Drop Shadow and Block Shadow. Fill options are available for Silhouette. 

Graphics Objects Tools

There are several tools in the Tool Palette that are used to create the graphic objects implied by
their name. They all work in an identical way except that the shape of the objects they create is dif-
ferent. 

• Rectangle tool

• Rounded-Corner Rectangle tool

• Star tool

• Oval tool

• Line tool

• Arc tool

When one of these tools is selected, the pointer should appear as a set of crosshairs.

To create an object: click on the appropriate tool, then move the pointer to the location where you
want one corner (or border) of the object to be placed. Click and hold the mouse button, then drag
to the location where you want the opposite corner to be, then release. The newly created object
appears with handles indicating that it is active.
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When creating an arc, the “direction” of the curve depends on the initial direction that you move
when you start to drag to the other corner . You can also use the rotation tool to rotate the object so
that it is curved in the proper direction after it has been created.

If the Shift key is held down during the creation process, the shape or orientation of the object is
constrained. Rectangle or rounded-corner rectangle boxes are constrained to a square. Ovals are
constrained to a circle. Non-orthogonal line orientation is constrained to 0°, 45° and 90°. 

If the rulers are displayed (see Show Rulers from the Page menu) the pointer is tracked on the
rulers before you press the mouse button to begin creation. During the drag, the content area of a
text or Picture Box and the endpoints of a line are tracked. This aids in the placement of the object. 

After using one of the creation tools, the Tool Palette reverts to the Object tool. To keep a cre-
ation tool selected for creating multiple objects, hold the Option key when you select the tool.

Speech Balloon Tool

The Speech Balloon tool is intended for creation of Speech Balloon objects, appearing as Text
Boxes with “balloon borders” similar to those in comic strips. There are twelve dif ferent balloon
types. Make a document bright and expressive by applying various colors, styles and shades to the
ballon and its text. To create a balloon with the help of the Speech Balloon tool, click on it, then
move the pointer to the location where you want one corner of the ballon. Click and hold the mouse
button, then drag to the location where you want to place the opposite corner , then release. 

You can easily change the appearance of the balloon by double clicking on it. After you are pre-
sented with the Balloon dialog box, select the balloon type you like most. Further modifications can
be implemented using Graphics menu options. To modify the text inside, use the Text menu com-
mands.

Bezier and Bezier Text Tools

Use the Bezier tool for adding Bezier curve objects to your documents. To create a curve, select
the tool from the Tool Palette. Click in the position where you want to locate the starting point of
the curve, then release the mouse. Now drag it to a new position. The current curve will be drawn
all the time you move the cursor . Click and drag the mouse to a new location again. Repeat the
process until the curve is completed, then make a double click with the mouse. The Bezier tool will
deactivate then, and the Object tool will become active.

The Bezier Text tool allows to display text along Bezier curves. After you define the curve, as
described above, you may add text and change text attributes, such as font, font size, color , and
shade. 
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Linking and Unlinking Tools

The Linking tool forms a connection between Text Boxes. Text “flows” between linked boxes as
if they were one continuous box. This flow of text between linked Text Boxes is referred to as a “text
chain”. The Unlinking tool is used to break the links between Text Boxes. 

When the Linking or Unlinking tool is selected, all links for an active text chain are displayed
when you click on a Text Box with in the chain. 

To link one Text Box to another, select the Linking tool. Click on the box you want text to flow
from, then click on the box you want text to flow to. An arrow is drawn between the “from” and
“to” boxes indicating the newly established link. You can continue clicking on new “to” boxes in
this manner, creating an entire text chain. 

Note: If you link to a Text Box that is already part of a chain, the box is “extracted” from that
chain before the new link is made. If your “from” box is in the middle of a chain, the “to” box is
inserted after it. You can’t link two boxes that both already contain text. 

To “extract” a Text Box from a chain: Select the Unlinking tool. Click on the Text Box you want
to extract. The box is activated in this manner and its links are shown by the arrows. Press the Shift
key, and click on the same box. This reroutes links around the extracted box. Any text that was in
the chain remains with the chain. 

Linking and unlinking on Master Pages: Text Box links can be made on Master Pages as well as
on other pages in a document. 

Equal Tool

The Equal tool is used for making one object the same size as another one. 

To use the tool, select it from the Tool Palette. The cursor changes to the Equal cursor. Click
on the first object, then on the second one. The second object changes its dimensions to be equal to
those of the first object. 
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Document Window 

When you create a new document or open an existing document, the Document Window associ-
ated with that document appears. 

The Document Window is used to contain the screen representation of one page (or two pages for
double sided documents) of the document you create. Each Document Window contains a lar ge,
blank service area surrounding the page(s) known as the Pasteboard, and the Screen Rulers, locat-
ed along the left and top sides of the window ..

Also, the lower left side of the Document Window is the Document Control Area. This contains
controls that allow easy access to a particular page of the document, and controls to change the view
size of the page.
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The Document Drawing Area, the page, is the printable portion of the document. This is the area
where you place and manipulate objects which are to be printed later. It also may contain non-print-
able service guide lines called Mar gin Guides. These are used for showing page mar gins and
columns, and Ruler Guides are used for positioning or aligning objects. 

The Margin Guides are configured in the Document Setup dialog box either when creating a new
document, or when selecting this option from the File menu.

Also, when selecting a number of columns, and spacing between them, the columns are shown
with the help of the Margin Guides. 

Ruler Guides are created by clicking and holding on the horizontal or vertical Screen Rulers, then
dragging the mouse to the desired position for the Ruler Guide. Ruler Guides can also be created by
acessing the Guide Settings… dialog box from the Edit menu. The latter option allows even dis-
tribution of up to 20 horizontal and 20 vertical Ruler Guides on your page.

The colors of the Margin and Ruler Guides can be changed using the Preferences… option in the
Edit menu. Also, you are able to make the Guides overlay or underlay all the other page objects.

The Pasteboard area is the non-printable area around the Document Drawing Area that may be
used for storing objects while creating your page design. When there are a lot of objects to be placed
on a page, sometimes it is dif ficult to position all of them exactly in the desired locations. Some of
them may be moved to the Pasteboard and used later . Since the Pasteboard is common for all the
document pages, moving objects to and from it is a way to move objects between pages, in addition
to cutting an object from one page, and pasting it onto another . Picture the Pasteboard as the table
on which the document pages lie.

The Document Control Area contains several elements. The View Size Contr ol, located in the
leftmost position of the Document Control Area, is used to change document view size. There are
several predefined view sizes contained in the pop-up menu, such as 25%, 50%, 75%, Actual Size,
200%, and the Fit view size. The last one calculates the view size so that the page fits the current
size of the Document Window.
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Other controls located in this area are (from left to right):

• Left and Right Master Page controls contain pop-up menus with the lists of all the Master
Pages available for your document. The lists are updated when you add, edit or remove
Master Pages using the Create Master Page, Master Page Options…, and Delete Master
Page menu commands in the Page menu.

Selecting a Master Page from the list makes the current document page contain all the
objects present on the Master Page. These objects may either underlay all the document
page objects, or overlay them. The Master Items in Front check box in the Preferences…
dialog box controls how Master Page items are displayed - above or under all document
page objects.

The Left Master Page pop-up is enabled when the document is double sided, i.e the Double
Sided Pages check box in the Document Setup… dialog box is checked. 

• The Previous and the Next Page buttons are used for navigating through your document.
Clicking on the Previous Page button displays the previous page. If the first document page
is displayed, clicking on the Previous Page button shows the last Master Page from the
Master Pages list. Subsequent clicks on this button navigate you through the list of the cur-
rently available Master Pages. 

If there are no more pages before of after the current one, the Previous/Next Page buttons
become disabled.

• The Page Number indicator and the Go To Page control allow you to display a particular
page of your document, and function the same way as the Go To Page… menu option from
the Page menu. 

Shortcuts with the Mouse

• Object Selection (with the Object tool): 

visible object click on item 
underlying object Ctrl-click 

• Object Resizing: drag handle

constrain * Shift-drag 
* constrains a box to square, an oval to circle, or a line to 0/45/90°

• Object Dragging: drag 

• Picture Operations

moving a picture in the box Option - drag
To play a Quick Time movie Cmd - Option click
To stop Quick Time movie click

• Info Dialog boxes activation double click on an object
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• Toolbar operations

Filling color Shift - color
Background color Ctrl - color
Toolbar moving drag
Toolbar Item moving Cmd - drag
Toolbar Item resizing Cmd - drag right side

• Text Highlighting

Clicking to Highlight Characters — The initial click within text positions the text insertion
point. A subsequent drag then highlights groups of characters. Alternatively, use Shift -
Arrow shortcuts to highlight text.

The highlighting is also possible by multiple clicks:

clicks characters highlighted
1 character by character 
2 words 
3 lines 
4 paragraphs

Shortcuts with the Keyboard

• Arrow Keys — Moving the text insertion point and highlighting text: 

Arrow Key
left previous character
right next character
up previous line
down next line
The Shift key can be used to extend the current selection. 

• To delete previous character Delete 

• New paragraph Return 

• New Line Shift - Return 

• Dialog Boxes Control:

Default button Return or Enter 
Cancel Cmd - .

• Change the Appearance of 
DesktopPublisher Pro Cmd - Option - Control - 0 (Zero) 
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File Menu

New Cmd - N

Open Cmd - O

Close Cmd - W

Save Cmd - S

Save As Cmd - Option - S

Import Text Cmd - M

Import Graphics Cmd - Option - M

Document Setup Cmd - Option - Shift - P

Print Options Cmd - Option - O

Page Setup Cmd - Option - P

Print Cmd - P

Quit Cmd - Q

Edit Menu

Undo Cmd - Z

Cut Cmd - X

Copy Cmd - C

Paste Cmd - V

Select All Cmd - A

Find/Replace Text. Cmd - F

Enter Find String Cmd - E

Find Next Cmd - G

Replace Cmd - L

Replace & Find Cmd - Option - L

Find/Replace Style Cmd - Option - F

Preferences… Cmd - Y
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Object Menu

Object Info Cmd - I

Frame Info Cmd - Option - I

Fill Info Cmd - Option - Shift - I

Text Runaround Cmd - R

Duplicate Cmd - D

Replicate Cmd - Option - D

Delete Cmd - K

Group Cmd - G

UnGroup Cmd -U

Bring To Front Cmd - ]

Send To Back Cmd - [

Shuffle Forward Cmd - =

Shuffle Backward Cmd - Shift - =

Nudge Up Cmd - Option - E

Nudge Down Cmd - Option - Shift - E

Align Objects Cmd - Option - A

Text Menu

Tabs Cmd - Shift - T

Char Info Cmd - Shift - H

Paragraph Info Cmd - Shift - G

Page Menu

Show Rulers Cmd - Option - R

Insert Page Cmd - Shift - A

Go To Page Cmd - J
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Working with Documents

DesktopPublisher Pro makes it easy to design and create useful, attractive documents.  This chapter
describes in detail all the features mentioned in the Program Overview section. All these features
combine to provide a single application with the ability to create all the diversity of the printing
products for any need.

Creating a New Document

To create a new document, select the New command from the File menu. The New Document
dialog box is displayed.

The Create Document fr om Scratch option allows you to create a new empty document, and
then add all the desired design elements to it. 

The Create Document From Template option shows all available DesktopPublisher Pro templates
- predefined documents containing a variety of design elements. Creating a document from template
will be discussed later in this chapter . 

Selecting Create Document from Scratch displays a Document Setup dialog box, that config-
ures the document settings.

• Page Size - specifies the size of the document’ s page. This can range from as small as 1"x
1", to as large as 18" x 18" (for facing-page documents) or 36" x 36" (for single - sided doc-
uments). Some predefined formats are:

US Letter 8 1/2" wide, 11" tall (default setting) 
US Legal 8 1/2" wide, 14" tall 
A4 Letter 210 mm wide, 297 mm tall 
B5 Letter 182 mm wide, 257 mm tall 
Tabloid 11" wide, 17" tall 
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• Units - the measurement units for all the numerical information in the dialog box. It speci-
fies also the units displayed on the rulers, when document is created.

• Margin Guides - specifies the distance from the guides drawn on a page to the edges of the
paper. 

• Double Sided Pages mode can be used for creating a document with two dif ferent page
types - left and right. Selecting this mode changes Left/Right mar gins to Inside/Outside
margins, and sets up the original Master Page with left and right page components. 

• Pages — defines the number of the starting page and the total number of pages in a docu-
ment. 

• Columns: Number and Spacing - defines the number of columns and spacing between
them for the original Master Page and the first page of the document. These columns are
marked using the Margin Guides.

• If Automatic Text Box is checked, the original Master Page and first page of the document
will contain the automatic Text Box that will have the specifications defined by the Page
Size, Margin Guides and Column Guides. 

• Page Orientation selects one of two possible page orientations - Portrait and Landscape.

Clicking OK displays a new Document Window. 
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Resizing the Document Window

Right after the Document Window appears on the screen, it is important to select the View Size
of the document. It is possible to increase or decrease it to make working with the document easi-
er.

Any View Size value between 10% and 400% percent in increments of 1% is available in
DesktopPublisher Pro. Also, there are predefined view sizes such as  25%, 50%, 75%, Actual Size, or
200%. Selecting one of them changes the display of the page to the corresponding amount of actu-
al size respectively.

Selecting Fit in Window changes the size of the display so that exactly one page is displayed in
the document layout window. 

The view size can be changed in a number of ways. First, using the View Size option in the Page
menu. Second, using the View Size box to the left of the Document Control Area of the Document
Window, and third, using the View Size box from the Page toolbar.

Customizing Rulers in the Document Window

By default, Screen Rulers are displayed along the top and left side of the Document Window.
Rulers can be displayed by using the Show Rulers command from the Page menu. If the Rulers are
currently being displayed, then the Show Rulers item will have a checkmark next to it. Selecting
this item when the checkmark is present and the Rulers are displayed hidesthe Rulers in the docu-
ment window.

The measurement units reflected in the Rulers are set through the Document Setup… dialog box
when the document is created and can be changed through the Ruler Settings… menu option in the
Edit menu.
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You can change Ruler settings also by clicking the upper left corner (intersection) of the Rulers
while pressing the Option key.

When you do so, the type of unit-measurement is displayed. The following units are available:
inches, picas, points, and centimeters.

Setting the Ruler Zero Point

To set the Screen Rulers’ zero point, click on the intersection of the Rulers, and drag to the point
where you want the zero point to be placed. As you drag the mouse, dotted lines are displayed on
the horizontal and vertical Rulers, helping you to determine the current position of the mouse. 

Adding Guides to a Document

There are two types of guide lines in  DesktopPublisher Pro - Margin Guides and Ruler Guides.  The
guide lines, or guides are non-printable service lines. Margin Guides are used for showing page mar-
gins and Ruler Guides are used for positioning or aligning objects. 

The Margin Guides are configured in the Document Setup… dialog box, either when creating a
new document, or when selecting the corresponding option from the File menu.

Also, when selecting a number of columns and spacing between them, the columns are indicated
with the help of the Margin Guides. 

The Ruler Guides are created either by clicking on the horizontal or vertical Screen Rulers, and
dragging a new guide to the desired position, or by using the Guide Settings… dialog box accessed
from the Edit menu. The latter option allows you to evenly distribute up to 20 horizontal and 20
vertical Ruler Guides on your page.
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Adding values to the Horizontal and Vertical fields allows you to change the guide frequency
for both horizontal and vertical guides. Use Units to specify the units of measure for the guides. It’s
possible to control the guides’ visibility using the Show Guides check box, which is identical in
action to the Show Guides option in the Page menu. Checking the Snap to Guides option makes
objects align their sides with the closest guideline when the distance between the guide line and the
side of the object is less then 5 pixels.

The Guide Settings are saved with the current document and are valid the next time the document
is open.

The colors of the Mar gin and Ruler Guides can be changed using the Preferences option in the
Edit menu.

Also, you are able to make the Guides overlay or underlay all the other page objects with the help
of the Guides in Back check box.

Creating a Document Design

DesktopPublisher Pro provides you with the capability to create unique documents to suit your par-
ticular requirements. Documents are constructed from following components:

• Geometric shape objects

• Text Boxes

• Picture Boxes

• Power Text objects

• Speech Balloon objects

• Bezier and Bezier Text objects

In the following sections the methods of placing these objects on a document will be shown, and
the process of creating a document design will be covered in detail.
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Adding Objects to a Document

What Are Objects?

Everything in a DesktopPublisher Pro document is an object: a  Text Box, a graphic, a line, a borde r,
a headline, etc. Every object can be moved, changed, resized, deleted, or duplicated independently
of other objects on the page. Each object has its own characteristics or attributes. Some of them are
common among the different types of objects, some of them are unique. This section of the manu-
al will explain the sorts of things you can do to  all objects on the page in a DesktopPublisher Pro doc-
ument.

All of the following are types of objects:

• Geometric Shapes

- Rectangles
- Rounded-Corner Rectangles
- Ovals
- Stars
- Lines
- Arcs

• Text Boxes

• Picture Boxes

• Power Text

• Speech Balloon

• Bezier and Bezier Text objects

Each particular type of object is covered in its own section in this manual. These sections will
deal with the unique characteristics of each type of object, as well as how to create the objects and
place them on a DesktopPublisher Pro document.  The section you are now reading will deal with the
properties common to all types of objects.

Placing an Object on a Page

When using DesktopPublisher Pro, you should use the  Tool Palette for placing an object on a docu-
ment. As described in the Tool Palette section, all the tools located there are tools responsible for
object creation. Only one type of object, Picture Boxes, are not by default created using the Tool
Palette; Picture Boxes are created using the Import Graphics menu option in the File menu.
However, you can customize the Tool Palette to add the Import Picture button to it. 
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To create an object of any type, except for the Bezier and Bezier Text objects, click on the appro-
priate tool, then move the pointer to the location where you want one corner (or end of a line) of the
object to be located. Click and hold the mouse button, then drag the mouse cursor to the location
where you want to place the opposite corner , then release the mouse button. 

The newly created object appears with handles indicating that it is active.

When creating an arc, the “direction” of the curve depends on the initial direction that you move
when you start to drag to the other corner . 

The Bezier and the Bezier Text types of object are created in a dif ferent way. To create such an
object, select the appropriate tool from the Tool Palette. Click in the position where you want to
locate the starting point of the curve, then release the mouse, and move it to a new position. A pre-
view of the current curve will be drawn as you move the cursor. Click and move the mouse to a new
location again. Repeat the process until the curve is completed, then double click the mouse button.

The Power Text and the Bezier Text objects require some additional information to be finished.
Dialog boxes are displayed, requiring data to be entered. This process is described in detail in the
corresponding sections later in this manual.

Selecting Objects

You will need to select an object if you wish to change or move it. Every object on the page can
be moved or changed independently of other objects. No object can be changed without first select-
ing it. To select objects, use the Object tool from the Tool Palette. Choose the Object tool by mov-
ing the mouse cursor over the Object tool in the Tool Palette and then clicking the mouse button.

You can than move the Object cursor over any object on the page and click the mouse button to
select that object. Once an object has been selected, a series of “handles” appear around the object.
Handles look like small black boxes. 
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These handles allow you to see whether an object is selected and are used to change the size and
shape of an object.

Selecting Multiple Objects: if the Object tool is still active, you can select multiple objects either
by holding down the Shift key on your keyboard while clicking on each of the objects in turn, or by
“dragging” a box around the items you want to select. 

To Remove an Object from a Multiple Selection: If you have multiple objects selected, and you
wish to remove one object from the multiple selection, hold down the Shift key again and click on
the object you wish to deselect. 

To Select All Objects: You can select all objects on a page by choosing Select All from the Edit
menu, or by using the corresponding shortcut with the keyboard.

To Deselect All Objects: To deselect all objects at once, click at a location on your document away
from all objects with the Object tool active.

Moving Objects

Once you have selected an object move it using the Object tool. Move the Object cursor over the
object, click and hold the mouse button, and drag the object to a new location. When the Object cur-
sor is over a selected object, it will change to the Move cursor , a set of four arrows.

This cursor lets you know that the object is ready to be moved. 

The crosshairs on the Screen Rulers show the current position of the object that is being moved
to help you position it on the page.
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Another way of moving objects is to use the Object Information dialog box to change the object’s
Origin Acr oss and Origin Down attributes. This is described under the CHANGING OBJECT
ATTRIBUTES section later in this manual.

Resizing and Reshaping Objects

Once an object is selected, you can change its size. The handles, or small black squares, around
the perimeter of an object are used to resize and reshape the object.

To resize or reshape a selected object: choose the Object tool from the Tool Palette and move the

Object cursor over one of object handles. The cursor changes to the Resize cursor . It looks like
a small pointing hand. Click and hold the mouse button and drag the mouse around. A dotted-line
box will follow your cursor , indicating the size and shape the object will be when you release the
mouse button.

Finally, objects can be resized/reshaped using the Object Information dialog box to change the
object Width and Height attributes. This is described under the CHANGING OBJECT ATTRIBUTES
section later in this manual.

Rotating Objects

To rotate an object, you must choose the Rotation tool from the Tool Palette. The Rotation
tool looks like an arrow moving in a circular direction. The object you wish to rotate must be select-
ed before it can be rotated. You may rotate multiple objects together as long as all objects have been
selected before you begin rotating them.

Once the Rotation tool has been activated, the cursor changes to the Rotation cursor . This
cursor is crosshairs in a circle.

Move the Rotation cursor over the object you wish to rotate. When you click and hold the mouse
button, the Rotation cursor becomes the pivot around which the object will rotate. A line appears
between the pivot point and the current mouse position. 

As you move the pointer around the pivot point, still holding down the mouse button, the line and
the outline of the object rotates. When you have placed the object in the desired orientation, release
the mouse button. 

If the Shift key is held down while rotating an object, the movement is constrained to 45° incre-
ments. Release the Shift key during rotation to permit full movement.
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Aligning Objects

You can align objects horizontally and/or vertically to clean up a document and put objects in
order.

All the objects to be aligned must first be selected before you choose Align Objects from the
Object menu. The “Align Objects” dialog box will be displayed.

In this dialog box you can select how you want the objects to be aligned. If you click on the To
First Selected Frame checkbox, the objects will all be aligned based on the location of the first
object you selected. If you leave this box unchecked they will be aligned based on the location of
the leftmost object.

You can align any number of objects as long as there is more than one object selected. If only one
object is selected, the Align Objects menu item will not be available.

Changing Object Attributes

Each object in DesktopPublisher Pro has a set of attributes that can be changed.  These attributes are
grouped together in the Object Information dialog box. The dialog box depends on the type of object
that was selected:

• Text Box Information

• Picture Box Information

• Graphics Item Information

• Line Information

• Group Information

In this section the Graphics Item Information dialog box elements will be discussed. Dialog boxes
for other types such as Text, Picture, and Group will be shown in the corresponding sections later
in this manual.
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• Origin Across, Origin Down - Repositions the original upper left corner of the object bor-
der or of the bounding box around multiple objects. These values are relative to the current
Ruler origin.

• Width and Height - Changes the size of the active Picture Box. Changing the box size does
not alter its origin. For a nonrectangular object, these fields control the bounding box size.
These fields are unavailable when more than one object is active. 

• Box Angle - Rotates the active Picture Box, or the bounding box around multiple Picture
Boxes, around its center . Rotating a constraining Picture Box rotates all constrained items
as well. 

• Printable - when unchecked, prevents the object from printing. 

• Locked - prevents any accidental replacing or moving of the graphics item.

• Visible - makes an item visible (or invisible).

• Units - indicates measurement units used for all the numeric information displayed.

When active items are all of the same type, choosing Object Info displays the corresponding
specifications dialog box. If all active items are Text Boxes the Text Box Information dialog box is
displayed. Fields containing values that vary among active objects are blank. Pop-up menus con-
taining values that vary among active objects show mixed settings.

When active objects are of different types (for example, Text Boxes and lines), choosing Object
Info displays the Group Information dialog box. 

When an active collection of objects contains a group, Object Info is not available. 

Changing Objects Stacking Order on a Page

All objects on a page in DesktopPublisher Pro have their positions in the stacking order on that page.
The object created most recently overlays existing objects and may cover the parts where they over-
lap.
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In the example shown below you can see that the Oval is above the Rectangle. Occasionally you
may want to move an object on top of other objects to make it more visible.

There are four menu options in DesktopPublisher Pro that allow changes to the objects ’ stacking
order. These are the Bring to Fr ont, Send to Back , Shuffle Forward , and Shuffle Downward
items in the Object menu.

To move an object forward or backward in the stacking order: select it, and then use one of the
above mentioned options. 

By default, the Object toolbar contains Bring To Front and Send To Back buttons.

Grouping and Ungrouping Objects

You can select multiple objects and make them behave as a single object. This allows you to
move, rotate and transform the objects together and make sure they are always in the same position
relative to one another. When objects are combined this way, it is known as a Group.

To Group Objects: Select all the objects you wish to combine into a group, and choose Group
from the Object menu.

To Ungroup Objects: Select the Group you wish to Ungroup then choose Ungroup from the
Object menu. 

To Group and Ungroup objects you may also use the corresponding buttons from the
Object toolbar.

You can perform many of the same basic operations on a group that you can on a single object,
for example, Cut, Copy, Duplicate, Delete, etc. However, you can’t resize a group.

When an active group consists of dif ferent kinds of items (for example, Text Boxes, and lines),
choosing Object Info from the Object menu, or double clicking on that group, displays the Group
Information dialog box. When a group consists of similar types of objects (for example, only Text
Boxes), choosing Object Info displays the corresponding information dialog box.
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Changing Frame Attributes of Geometric Shapes

Frames are boxes around objects. In DesktopPublisher Pro they have five attributes which can be
changed. These are:

• Line Width

• Line Style

• Line Color

• Line Shade

• Line Pattern

The attributes of the selected object can be changed using the corresponding menu options from
the Graphics menu. To change an attribute, scroll to the desired item in the corresponding pop-up
menu and release the mouse button. 

The Line Width attribute can be changed from 0 points to 100 points in 1 point increments. There
are seven commonly used line widths in the menu. Selecting the Other… option invokes the Other
Value dialog box for entering any value within the 0 - 100 points range.

The Line Style can be selected from the nine line styles available in DesktopPublisher Pro. (For some
shapes, the last three styles are disabled.)

The Line Color can be selected from all the colors available for the current document. Colors can
be added, deleted and edited in DesktopPublisher Pro. More information on colors is in the  ADDING
COLORS TO A DOCUMENT section later in this manual.

The Line Shade value, which means the density of color , can be changed from 0% to 100% in
1% increments. Using the Other… option displays the Other Value dialog box for entering any
value withing the 0 - 100% range.

The Line Pattern can be selected from the line patterns available in DesktopPublisher Pro.
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Another way of setting the Frame attributes is to use the Graphics toolbar .

Using toolbar elements to change Frame attributes is the same as using menu commands. Except
for the Other… option, which is not present in this case.

The third way is to use the Frame Info option from the Object menu. When doing so, the Frame
Information dialog box is displayed.

In addition to the attributes listed above, the dialog box contains the following elements:

• The Sample field is located in the upper right corner of the Frame Information dialog box
and previews the selected settings.

• The Visibility group contains four check boxes. They are active whenever the current object
is rectangular. Unchecking any of them erases the appropriate side of the text frame. For
example, unchecking the Above check box displays the object frame without its top side.
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Changing Fill Attributes of Geometric Shapes

Fills affect the interior of objects. In DesktopPublisher Pro they have four attributes which can be
changed. These are:

• Fill Color

• Fill Shade

• Fill Pattern

• Background Color

The fill attributes of the selected object can be changed in three ways. First, using the corre-
sponding menu options from the Graphics menu. To change an attribute, scroll to the desired item
in the corresponding pop-up menu and release the mouse button. 

The Fill Color and Background Color can be selected from all the colors available for the cur-
rent document. The Fill Color changes the color in the interior of an object where the Fill Pattern
is solid. The Background Color specifies the color in the rest of the interior of the object. The col-
ors can be added, deleted and edited in DesktopPublisher Pro. More information on colors is in the
ADDING COLORS TO A DOCUMENT section later in this manual.

The Fill Shade value, which defines the density of color , can be changed from 0% to 100% in
1% increments. Using the Other… option displays the Other Value dialog box for entering any
value withing the 0 - 100% range.

The Fill Pattern can be selected from the line patterns available in DesktopPublisher Pro.

The second way of setting the Fill attributes is to use the Graphics toolbar. Pressing the Shift key
and selecting a value from the Graphic toolbar changes the corresponding Fill attribute. Pressing the
Control key along with the color selection changes the Background Color .
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The third way is to use the Fill Info option from the Object menu. When doing so, the Fill
Information dialog box is displayed.

In addition to the attributes listed above, the dialog box controls an object’ s visibility.

• The Visibility group contains two radio buttons. Making an object clear changes the Fill
Pattern to clear pattern. So, if you switch to Opaque, be sure to return the pattern to the
desired value.

Adding Shadows to Rectangular Objects

The Shadow Info command in the Object menu controls shadows of rectangular objects, such
as text, Picture Boxes, and rectangles. 

When selecting this option, a dialog box appears which allows you to add and remove shadows,
and specify the shadow Color, Shade, and Offset from the box.

The Sample field is located on the right of the Shadow Information dialog box and shows a pre-
view of the changes you make.
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Duplicating Objects

DesktopPublisher Pro provides you with a means of making single and multiple copies of a selected
object. Duplicating an object is a sequence of copying and pasting operations combined in one step.
Also, such settings as horizontal and vertical of fsets are taken into account when specifying the
location of the duplicate of an object.

The horizontal and vertical of fsets that were last specified in the Replicate dialog box specify
where the copy is placed. If Replicate hasn’t been used since running Mac Publisher Pro, the dupli-
cate is placed 5 points to the right and below the original.

The Replicate command is used to make multiple copies of an object. 

When this command is selected from the Object menu, a dialog box appears that allows you to
control these settings:

• Replicate Count - specifies the number of copies to make. 

• Horizontal Offset - the horizontal distance between copies. A positive value places dupli-
cates to the right of the original. A negative value places duplicates to the left. Preset to 5
points.

• Vertical Offset - the vertical distance between copies. A positive value places duplicates
below the original. A negative value places duplicates above. Preset to 5 points. The
Horizontal and Vertical Offsets you specify become the default Replicate and Duplicate
offsets, until you quit from the program. 

• Units - indicates measurement units used for all the numeric information displayed.

Duplicating Text or Picture Boxes duplicates their contents as well.

A duplicate of a Text Box that is part of a chain contains all the text, that would contain the part
of the chain, beginning with that box.

To make a single or multiple copies of the desired object: select it, and use the Duplicate or
Replicate command from the Object menu, or their keyboard shortcuts.
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Deleting Objects

Objects that are not used any more can easily be removed from a DesktopPublisher Pro document by
selecting them, and then, by either using the Delete command from the Objects menu (or its key-
board shortcut), or the Clear command from the Edit menu. 

There is a Clear button on the Edit toolbar, and it is possible to add the Delete button using Edit
Toolbars… Customize… option. See the corresponding sections for information on customizing
toolbars.

Working with Picture Graphics

Picture graphics are an important part of any publication.  That is why  Desktop Publisher Pro can
accept graphics in a variety of different forms. The need to select an imported picture makes Picture
Box creation unique among object creation. By default there is no Picture Box tool in the Tool
Palette. The Import Graphics menu option in the File menu can be used instead. 

When you select Import Graphics… from the File menu, a dialog box appears that allows you
to specify the file from which the picture is to be imported. 

In addition to all the standard elements, it contains a list of file types for import. If a particular
file type is selected from the list, this means files of only that type will be displayed in the files scroll
list, thus making import easier. Selecting the All Readable option allows you to view files of all the
formats that DesktopPublisher Pro is able to import.

The size of the picture to be imported, and the number of colors used, are displayed in the dialog
box.
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If no Translation Manager is installed on your system, then DesktopPublisher Pro uses its own trans-
lation capabilities. Only six graphic formats are accepted in this case, including: 

• MacPaint format graphics 

• PICT format graphics 

• Encapsulated PostScript® (EPS) graphics 

• Tag Image File Format (TIFF) images 

• GIF images 

• Quick Time (Cmd-Option-click in a preview to play a Quick Time movie, and single click
on the playing movie to stop).

If the Picture Preview is on, a representation of the picture is displayed when you select its name
in the file list. 

The cursor changes to the Picture cursor after selecting the desired picture from the file list
in the dialog box, showing that you are about to create a new Picture Box. Move the cursor to the
location where you want one corner of the box to be placed, then click and hold the mouse button.
Drag the cursor to the location where you want the opposite corner to be and release the mouse. The
newly created Picture Box appears with the selected picture inside and handles around the perime-
ter indicating that it is active.

You can also simply click on a document with the Picture cursor . This will create a new Picture
Box with the dimensions equal to the dimensions of the picture being imported. However , this pro-
vides less control during the import.

Note: If you had an active Picture Box on your page when first importing a picture, the picture
would be imported into that box. If you want to import it into a new Picture Box, make sure that no 
existing Picture Box is currently active. 

Some attributes of the active Picture Box can be changed using several tools from the Tool
Palette. To change the location and dimensions of a Picture Box, click and drag the Picture Box with
the Object tool, or drag one of its resize handles. To change the box angle, use the Rotation tool.
These operations are common for all DesktopPublisher Pro objects and are described in the  WORKING
WITH OBJECTS section earlier in this manual.

Select the Picture Mover tool from the Tool Palette o move a picture inside its box, 

Once the Picture Mover is selected, the cursor changes to the Hand pointer when the cur-
sor is over an active Picture Box. Click and drag the mouse2 to move the picture insidethe Picture
Box. You can also move a picture inside its box with the Object tool. To do this, hold down the
Option button as you click on the picture and drag.
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The most comprehensive way to control Picture Boxes in DesktopPublisher Pro is to use the Picture
Box Information dialog box. It is displayed when selecting the Object Info option is chosen from
the Object menu while one or more Picture Boxes are active.

Each attribute is defined below:

• Origin Across, Origin Down - repositions the original upper left corner of the Picture Box
or the bounding box around multiple Picture Boxes. These values are relative to the current
Ruler origin. 

• Width, Height - changes the size of the active Picture Box. Changing the box size does not
alter its origin. These fields are unavailable when more than one Picture Box is active. 

• Box Angle - rotates the active Picture Box, or the bounding box around multiple Picture
Boxes, around its center . Rotating a constraining Picture Box rotates all constrained items
as well. 

• Offset Across, Offset Down - adjusts the distance between the original upper left corner of
active Picture Boxes and the picture each box contains. 

• Picture Angle - rotates the pictures in active Picture Boxes around each picture’s center (as
determined by the application in which the picture was created), independent of its Picture
Box. 

• Scale Across, Scale Down - adjusts the size and proportions of the pictures in active Picture
Boxes from 10% to 1000%. Changing picture scale doesn’ t alter the picture offset. 

• Printable - when unchecked, prevents the pictures in active Picture Boxes from printing.
Frames and background colors are still printed. 

• Locked - prevents any accidental replacing or moving of the Picture Box.

• Visible - makes an object (a picture with its box) visible or invisible.

• Scale with Box - resizes the picture to its box height and width
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• Display - displays or does not display the picture on the screen. The corresponding Picture
Box is still displayed.

• Printout - when unchecked, prevents the pictures in active Picture Boxes from printing.
Frames and background colors are also not printed.

• Units - indicates measurement units used for all the numeric information displayed.

You can use the Clipboard to import pictures from other applications. When you Copy a picture
image from other applications and then  Paste it in your document. DesktopPublisher Pro automatical-
ly creates a Picture Box on the current page of the document, and inserts the picture. The dimen-
sions of the box created are equal to those of the picture being pasted.

Using Editions

The Editions command is used to control a subscription to another document. Selecting and hold-
ing the mouse on Editions in the Edit menu activates a submenu. This submenu provides two
options, each of which activates a dialog box. The Subscribe To… selection dialog box allows you
to specify a document to which you wish to subscribe. The Subscriber Options… dialog box is
used to specify the attributes of a subscription, including timing of updates and cancelling of sub-
scriptions. A full description of the subscription process can be found in the Macintosh System doc-
umentation.

Working with Text

Placing a Text Box on a Document

The Text Box tool is used to create a new Text Box, a rectangular region in which text is placed.

To create a Text Box, click on the Text Box tool , then move the pointer to the location
where you want one corner of the Text Box to be placed. 

The pointer appears as a set of crosshairs. Click and hold the mouse button, then drag to
the location where you want to place the opposite corner of the Text Box, then release the mouse
button. 

Lines mark the boundary of the newly created Text Box, and handles on those lines indicate that
the Text Box is active. Note that Mac Publisher Pro changes the pointer to an I-beam and places it
in the upper left corner of the newly created Text Box. This is done so that you can start typing text
immediately.
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Text Box Information

Text Boxes have a number of attributes unique to their function. These attributes are grouped in
the Text Box Information dialog box., displayed when more then one Text Box is active and Object
Info is chosen from the Object menu, or double click on a Text Box with the Object tool active. 

The Text Information dialog box contains edits the following attributes: 

• Origin Across, Origin Down - repositions the upper left corner of the Text Box or the
bounding box around multiple Text Boxes. Values are relative to the current Ruler origin. 

• Width, Height - changes the size of the active Text Box. Changing the box size does not
alter its origin. These fields are unavailable when more than one Text Box is active. 

• Box Angle - rotates the active Text Box, or the bounding box around multiple Text Boxes,
around its center. Rotating a constraining Text Box rotates all constrained items as well. 

• Text Inset - specifies the space between text and the inner edges of active Text Boxes. 

• Printable - when unchecked, prevents text from printing. 

• Locked - prevents any accidental replacing or moving of the Text Box.

• Visible - makes an object visible or invisible.

• Text Runaround - makes the text contained in a Text Box wrap around all the objects that
are higher in object stacking order on the page, and overlay the Text Box

• Units - indicates measurement units used for all the numeric information displayed.
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Adding Text To a Text Box

After placing a Text Box on a document, you are able to enter text. There are three methods:

- typing at the keyboard

- pasting from the clipboard

- importing text files

• To type text directly into a Text Box, choose the Text tool from the Tool Palette. The
pointer changes to the text insertion bar when moved over the active Text Box. If there is
no text in the box yet, click on the Text Box, or, if there is already some text, click where
you want to start entering text. The vertical bar that appears is the text insertion point.New
text will appear immediately to the left of the text insertion point when entered.

You can move the text insertion point anywhere in the active Text Box by clicking on a new
location. You can also move the text insertion point one character to the left or right using
the left or right arrows on your keyboard, and one word to the left or right pressing the
Option key while using the left or right arrows keys. Using the up or down arrows moves
the text insertion point one line up or down. 

After placing the text insertion bar in the Text Box, text will appear character by character
as you type. Each time you type a character , the location of the text insertion point moves
to the proper location for the next character (this may depend on the location of tab stops
and paragraph alignment mode, as described later on in this section). Pressing Delete
removes the character immediately to the left of the text insertion point.

• The clipboard allows you to transfer text from other locations in a DesktopPublisher Pro docu-
ment, or from other applications. Copy and Cut are the two commands in the edit menu that
place text on the Clipboard. Use the mouse to highlight the area of text to be copied.

Once the text has been copied to the clipboard, it can be placed immediately at the text inser-
tion point by using the Paste command or its keyboard shortcut. 
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• When you select Import Text from the File menu, a dialog box appears allowing you to
specify the file from which the text is imported. 

In addition to the standard elements, it contains a list of file types for import. If there are
any translation extensions installed on your computer , like MacLink Translators, the list
includes all the file types these extensions support. Otherwise, only the ‘Text’ file type will
be in the list.

If a particular file type is selected from the list, only files of that type will be displayed in
the files scroll list. This simplifies searching for specific files. Selecting the All Readable
option allows you to view files from all formats that DesktopPublisher Pro is able to import.

The length of the text file to be imported is also displayed in the dialog box.

In the preview area, the first lines of the selected file are displayed to indicate file contents. 
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Formatting Text

A group of text settings are used to control how text is placed in the Text Boxes on a page. Using
DesktopPublisher Pro menus, toolbar elements, and dialog boxes allows you to fully control the format
of text.

All these settings are grouped in the Paragraph Information dialog box. It can be displayed with
the help of the Paragraph Info menu command in the Text menu or its keyboard shortcut. This acti-
vates a dialog window that displays, and allows you to modify , the attributes of the current para-
graph. 

The current paragraph either contains the highlighted text or the text insertion bar . 

• Left Indent - the horizontal distance between the left side of the Text Box, and the left mar-
gin of the current paragraph. 

• First Line - the horizontal distance between the left mar gin of the current paragraph
(defined by the left indent), and the first character on the first line of the paragraph. If the
value is negative, the first character appears to the left of the paragraph mar gin. This
becomes a hanging indent. If it is positive, the first character appears to the right of the para-
graph margin. This becomes a normal indent.

• Right Indent - the horizontal distance between the right mar gin of the current paragraph
and the right side of the Text Box.

• Leading - the distance between the baselines of successive lines of text. This attribute can
be changed using the Line Spacing menu option, and the Line Spacing toolbar element
from the Text toolbar.

• Space Before - this value specifies the distance between the last line of the previous para-
graph and the first line of the current paragraph.
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• Space after - this value specifies the distance between the last line of the current paragraph
and the upper boundary of the next paragraph.

• Keep with Next - the current paragraph and the next paragraph are kept in the same Text
Box. 

• Keep Lines Together - lines of the current paragraph are kept in the same Text Box. 

• Drop Caps - allows you to make the first letter of the selected paragraph the height of a
specified number of lines of text. The number is contained in the Number of Lines edit box
right under the Drop Caps check box. The picture below shows text with the drop caps on:

• Alignment - contains the pop-up menu that allows you to select from five types of the para-
graph alignment, Left, Right, Center, Justified, and Force Justified. Drag to and highlight
the desired alignment and then release. 

The alignment can also be changed with the help of the Alignment submenu from the Text
menu, and the group of Alignment buttons from the Text toolbar. 

• Units - the pop-up menu is activated that allows you to select from four units of measure,
Inches, Points, Centimeters, and Picas. Drag to and highlight the desired measurement
unit and then release. 

To modify an attribute, enter a new value in the edit field of the dialog box where the current
value is being displayed, or use menu commands, and the appropriate toolbar elements. 

Adding Styles to Text

Text attributes that are: Font, Size, Color, Style, Shade, Spacing, and Line Shift. All of them
are located in the Character Information dialog box. Also, it is possible to change them using the
Text menu options, and some toolbar elements from the Text toolbar.
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Selecting Character Info from the Text menu activates a dialog window that displays, and
allows you to modify, attributes of text characters. 

The character attribute commands work in two dif ferent ways. If text is highlighted when you
select this command, only the characters in that text are changed. If no text is highlighted, then text
entered at the text insertion bar will appear with the new set of attributes.

Setting Tabs

Clicking on the Tab button moves the text insertion point to the right by the default tab width.
The default value is set in the Text panel of the Preferences dialog box, accessed via the Edit menu.

These Tab stops are left, which means that the stop is always to the left of the text. To allow more
control, DesktopPublisher Pro has custom tabs support, allowing you to add different types of tab stops,
to place them at specified positions, and to add leading characters.

Selecting Tabs from the Text menu activates a dialog box which allows you to add or remove
custom tab stops to the the current paragraph. 

The current paragraph is the one that contains highlighted text or the text insertion bar . 
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The dialog box contains the Alignment pop-up menu., Leading Character and Position edit
fields, and Add, Delete and Clear All buttons. A ruler shows the tab stops already added. 

On the picture above, the ruler from the Tabs dialog box is shown. It contains:

• paragraph attributes (see Formatting of Text above in this manual)

- the Left Indent of text - left lower triangle
- the First Line of text - left upper triangle
- the Right Indent of text - right triangle

These triangles can be moved on the Ruler , changing the current paragraph settings.

• Tab Stops - The three stops shown in the picture are Right, Left, and Center . The Left stop
is the tab stop that is always to the left of the text, the Right tab stop is always to the right
of the text, and the Center stop remains in the center of the typed text.

You can add, move and remove the tab stops from the Ruler .

To add a tab stop: select a desired alignment from the Alignment pop-up menu and click
on the Ruler, or specify the desired position in the Position edit field, and click Add button.

To move a tab stop: select it by clicking on it, then drag to the desired position, or enter a
new value into the Position edit box.

To remove a tab stop:select it by clicking on it, then drag it out of the Ruler , or click on the
Delete button. To remove all the tab stops, click on the Clear All button.

The tab stops attributes are described below in more detail.

• Alignment: Alignment can be either Left, Right, or Center.

- Left alignment causes the first character of text typed at the tab stop to be located at
the tab stop position. Additional characters are typed in to the right of the tab stop.

- Right alignment causes the last character of text typed at the tab stop to be flush to the
tab stop position.Additional characters are typed in to the left of the tab stop.

- Center alignment causes the text segment to be centered with respect to the tab stop
position. As additional characters are typed in, the text segment is expanded both to the
left and the right of the tab stop position, so the text segment remains centered on the
tab stop.

The alignment of a tab stop is set by opening the pop-up menu to the right of the Alignment
display box in the Tabs dialog window. There are three options, drag to the desired selec-
tion and release. The selected alignment now appears in the display box.

87

Desktop Publisher Pro by Cristallight 



• Leading Character Sequence: The lead character sequence can be any valid sequence of
characters, including a space.

The lead character sequence is used to fill white space between the end of a text segment at
a tab stop and the text segment directly to the left of it. You specify the lead character
sequence by typing it directly into the edit field to the right of Leader in the Tabs dialog
window, and entering return or tab. Alternatively, you can activate a pop-up menu by click-
ing and holding on the arrowhead to the right of Leader , and then drag to and select one of
the predefined lead character sequences.

• Position: The position can be set at any location on the horizontal Ruler . 

The position attribute of a tab stop is specified by typing the value into the edit field to the
right of Position. The unit of measure for the position is the same as that being used for the
horizontal screen ruler.

Style Sheets

Style sheet is a predefined set of character , paragraph, and tab stop attributes. Style sheets sup-
port is convenient and speeds up work on text documents. Style sheets are stored with documents.

The Edit Style Sheets… command in the Edit menu allows you to create custom style sheet def-
initions or change the existing style sheets in a DesktopPublisher Pro document. It displays the Style
Sheets dialog box with a list of the style sheets available for the current document, and buttons for
adding, deleting, editing and importing style sheets from other documents.

To create a style sheet from an existing style sheet: Select a custom style sheet from the list, and
click Duplicate. This copies the style sheet. Editing a style sheet is described later in this manual. 

To delete a style sheet: Select a custom style sheet from the list, and click the Delete button. Note
that the Normal style sheet can’ t be deleted. 

To add style sheets from another DesktopPublisher Pro document: Click Append, and select the doc-
ument with style sheets you want to add. An alert is displayed if the source document has a style
sheet with the same name as a style sheet in the tar get document. You may add the style sheet with
the same name by clicking Rename New Style. 
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To create a new style sheet, or edit an existing style: Click New or Edit and the corresponding
dialog box is displayed. Use this dialog to create a new style sheet: 

• Style Name - the name of the style sheet.

• Next Style - the style sheet applied when a carriage return is used while typing. ‘Self’ means
that the next style is the same. Useful if you always have, for example, a paragraph of
Normal sytle following a paragraph in Headline style.

• Character, Paragraph, Tabs, Rule Above, and Rule Below display dialog boxes where
style sheet attributes can be specified. The Character, Paragraph, and Tabs boxes are
described in previous sections of this manual. 

Rule Above and Rule Below are similar in function to each other. They allow you to display and
modify the line (or rule) above and below the paragraph to which the style sheet with these options
is applied.

• The Display check box specifies if this Ruler is to be displayed. By default it is of f.

• The Color, Shade, Style and Width define the rule settings.

• From Left - is the distance between the line start and the left text mar gin.

• From Right- is the distance between the line end and the right text mar gin.
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• Length - may be either Text, or Indents. If Text is selected, the rule length is calculated
using the actual length of the text, and if Indents, the line will be displayed from the Left
Indent to Right Indent of the paragraph.

• Offset - if the Space Before and Space After values from the Paragraph info dialog box are
not zero for the current style sheet, you may want to specify the vertical of fset of the rule
from either the first or the last lines of text. The offset is calculated in percents of the Space
Before and Space After values for above and below rules correspondingly.

Searching for Specific Text

The middle section of the Edit menu contains menu commands that allow you to search for a spe-
cific text in the currently active document. 

Selecting Find/Replace from the Edit menu activates a dialog box that allows you to search the
document for specific text, or pattern using special characters. 

The following options are available: 

• Whole Word - finds only occurrences that are distinct words (not embedded in other text).
For example, if you search for “the” with Whole Word checked, only the word “the” will
be found, but not “their” or “other .” If Whole Word is unchecked (default setting), any
occurrence of the specified text, regardless of its position within other text, is found. 

• Ignore Case - (default setting) finds any occurrence of the specified text, regardless of its
capitalization. If Ignore Case is unchecked, the exact capitalization as entered must be pre-
sent. 
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To find text: Enter the text you want to find in the field labeled Find. Enter the replacement text
in the Change field. Leave this field blank if you want to search for (but not change) specific text,
or if you want to delete the search text. Position the text insertion point where you want the search
to begin. 

The four buttons on the bottom of the Find/Replace dialog box control the search and changes:

• Find Next - begins the search, or finds the next occurrence of the specified search criteria

• Replace - changes the highlighted tex to match the Change field

• Replace& Find - combines the functionality of the Replace and Find Next buttons

• Replace All - changes all occurrences of the search criteria. An alert is displayed showing
the number of occurrences changed

The Enter ‘Find’ String, Find Next , Replace, Replace&Find, and Replace All menu com-
mands add flexibility when using the search options. There are some cases in which it is not neces-
sary to display the Find/Replace dialog box to find all the occurrences of a word that already exists
in your text. Just select that word, and use the Enter ‘Find’ String command. Then, using the Find
Next command or its keyboard shortcut, find this word in the rest of your text.

Searching for a Specific Text Style

It is possible to search not only for a specific text pattern or a word, but to use text styles as search
criteria. It is easy to find all the occurrences of the text displayed in, for example, Helvetica, 10,
Bold.

To accomplish such an operation, use Find/Replace Style from the Edit menu. This command
activates a dialog box that allows you to search the document for styles, using the set attributes you
specify as search criteria. It also provides a means of changing the style of the text found this way . 
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To find a specific style: using the Font and Size pop-ups, and Face check boxes group, specify a
search criterion, then use one of the buttons on the right of the Find/Replace Style dialog box. 

• Find Next - begins the search, or finds the next occurrence of the specified search criteria. 

• Replace - makes changes specified by the Replace column. 

• Replace All - changes all occurrences of the search criteria. The alert is displayed that
shows the number of occurrences changed. 

Linking and Unlinking Text Boxes

Two or more Text Boxes can be linked into a text chain. This means that such a connection
between Text Boxes is established, that text “flows” between linked boxes as if they are one con-
tinuous region. 

Linking Text Boxes is implemented with the Linking tool in the Tool Palette.

To link one Text Box to another: Select the Linking tool. Click on the box you want text to flow
from. Then, click on the box you want text to flow to. An arrow is drawn between the “from” and
“to” boxes indicating the newly established link. You can continue clicking on new “to” boxes in
this manner, extending the text chain. 

Note: If you link to a Text Box that is already part of a chain, the box is “extracted” from its chain
before the new link is made. If your “from” box is in the middle of a chain, the “to” box is inserted
after it. You can’t link two boxes that both contain text. 

The Unlinking tool is used to break the links between Text Boxes. 

To unlink Text Boxes or to “extract” a Text Box from a chain: Select the Unlinking tool. Click
on the Text Box you want to extract. The box is activated in this manner and its links are shown by
the arrows. Press the Shift key, and click on the same box. This reroutes links around the extracted
box. Any text that was in the chain remains with the chain. 

When the Linking or Unlinking tool is selected, the links for the active text chain become dis-
played as soon as you click on a Text Box. 
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Inserting a Page Number into a Text Box

DesktopPublisher Pro allows you to insert a page number to  Text Boxes located on that page.  This
may be convenient in some cases. As an example of using this feature, the additional way of num-
bering pages of a document is shown below. 

Placing a Text Box on a Master Page, and inserting (with the help of the Insert Page Number
command) a page number in it, displays “Document Master” in the Text Box. This indicates that the
current page is the Master Page. 

The document pages, using this Master Page, will contain their page numbers on them in one of
the formats specified when inserting the page number:

1,2,3,4 Numeric

I,II,III,IV Upper case Roman

i,ii,iii,iv Lower case Roman

A,B,C,D Upper case Alphabetic

a,b,c,d Lower case Alphabetic

Text Runaround

The Text Runaround option is used to control how the text contained in a Text Box flows around
objects that overlay that Text Box. There are three modes of flowing text:

• None - text flows unobstructed. 

• Rectangular boundary of object - text is obstructed by and flows around the rectangle
containing the object. 

• Actual shape of object - text flows around the outline of the object (such as oval, or trans-
parent pictures). 
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To make the text flow around the object that overlays it, select the overlaying object with the
Object tool, and then use the Text Runaround command from the Object menu. In this case the
Text Runaround dialog box appears, allowing you to set the text flow mode around that object.

The Gap Between Text and Border value offsets the text from the object edges. This value is
displayed in points. 

Text Statistics

DesktopPublisher Pro allows a user to get some text statistics.  These are contained in the  Text
Statistics dialog box.

The dialog box contains the information about the entire text present in your document. 

• Number of Text Frames - the number of the Text Boxes currently in your document

• Number of Text Chains - when two or more Text Boxes are linked using the Linking tool,
they create a text chain. The number of the chains is displayed in this window

• Number of Text Paragraphs - the total number of paragraphs in all the Text Boxes of the
entire document

• Number of Words - the total number of the words used in the document. This can be par-
ticularly useful for assignments based on word count
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Spell Checking a Document

When working with a DesktopPublisher Pro document you can spell check different parts of it as well
as the whole document. Selecting the Spelling option from the Text menu displays the submenu
containing these options:

• Word/Selection - spell-checks only the word containing the text insertion point, or the
words within the currently highlighted text range, 

• Paragraph - spell-checks only the current paragraph,

• Story - spell-checks all the text in the current Text Box, or the current chain of linked Text
Boxes.

When the Spell Check dialog box is displayed, you are presented with a list of words from the
DesktopPublisher Pro dictionaries similar in spelling to the suspect word. 

To replace the suspect word with another contained in the list: Select the word in the list and click
Replace, or double-click on the word. 

The Add and Remove buttons allow you to edit the User Dictionary contents.
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To add a new word to the DesktopPublisher Pro User Dictionary: click on the Add or Full Add but-
tons. If the Add button is pressed, the word is immediately added to the dictionary. Otherwise, you
are presented with the Add to Dictionary dialog box, containing various suffixes you may add with
the word. 

To remove a word from the dictionary, select it in the list box and click on the Remove button.

Capitalize as Suspect - if the option is on, then if the the suspect word is capitalized in your text,
then the word it is replaced with will also be capitalized after it is pasted into the text.

You can edit the contents of the User Dictionary using the Edit User Dictionary command from
the Edit menu.

The functions of the Add, Full Add, and Remove buttons from the Edit User Dictionary dialog
box are the same as in Spell Check dialog box.
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Using the Thesaurus

When using the Thesaurus, DesktopPublisher Pro finds and displays a list of synonyms and antonyms
to the specified word from the thesaurus database distributed with DesktopPublisher Pro.

The Thesaurus dialog box contains the word list table, Find and Replace buttons, and Categories
and Senses pop-up menus. 

To find words similar to the desired word: Type the word into the edit field above the word list,
and click Find. All the found words are added to the list. If the list is not empty, you can select any
word from it by clicking on it in the list. Subsequent clicking on the Replace button either replaces
the highlighted range of text, or inserts the word at the current text insertion point. 

If you click the Find button after selecting the word from the list, or just double click on a word
in the list, this word will be used as a new search word. 
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Changing Text Preferences

There are a number of text attributes that may be changed for the current document, and saved to
be used as defaults when creating new documents. All of them are grouped into the Text panel of
the Preferences dialog box.

• All Caps value - specifies the percentage of a font height in All Caps font style and the font
height in plain font style.

• Superscript and Subscript values indicate the percentage of the current font size baseline
shift for that given font. Superscript shifts the baseline up, while Subscript down.

• Text Wrap/Hyphenation switches between the two modes of text lines breaking. When
switched to Text Wrap, lines break at the end of the words only , Hyphenation searches for
possible word breaks also.

• Smart Quotes check box and pop-up allows you to activate the smart quotes mode and to
select the desired type of smart quotes to be used with your text.

• Tab Width edit field allows you to change the length of tabs in DesktopPublisher Pro from
twenty points, which is standard, to any other value.

• Draw ¶ allows special characters (such as Return, Tab, etc) to be drawn in gray.

Changing any of these attributes a ffects the current document.  To make them DesktopPublisher Pro
defaults, click the Make Default button. New documents created afterwards will use the new set-
tings.
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Working with Power Text

Placing a Power Text object allows you to present text in special forms with color and shade
effects. Power text fills the entire Text Box, expanding or contracting as necessary , but always
extending to the outermost boundaries of the box.

To create a power text object, select the Power Text tool from the Tool Palette, then move the
pointer to the location where you want one corner of the object to be placed. Click and hold the
mouse button, then drag to the location where you want to position the opposite corner of the object,
then release. 

The Text Effects dialog box is displayed. With its help you are able to enter the text for the power
text object and to select existing text ef fects, or to create new custom ef fects. The dialog box con-
tains:

• Two edit boxes. Power Text allows two lines of text up to 60 characters to be entered

• Font pop-up, containing the list of all the True Type fonts installed on your system

• Shape pop-up, containing up to twenty predefined shapes used with Power Text objects

• Alignment pop-up, allows selection among Left, Right, Center or Justify alignments. The
Justify option is available only when the text consists of two lines

• The built in library of Custom Style Ef fects, and two buttons with right and left arrows on
them for styles navigation

• Add Style and Delete Style buttons enable you to add a new style to the Style Ef fects
library or to remove one of existing styles

• Custom button, which lets you create a new custom style
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To enter text in the Power Text Box:: click on the first edit box and, after the text insertion point
appears, type in your text. 

Look through the existing styles, and select the one you like most. The Power Text will then look
like:

The second line is aligned left. To change it, return to the Text Effects dialog box by double click-
ing on the object, and select Center from the Alignment pop-up.

Creating a Custom Style: There are many styles present in the Custom Ef fects library. You can
also create your own style. Clicking on the Custom button presents you with the Character Effects
dialog box to change the appearance of text characters. There are four groups of settings, enabling
you to create Custom styled text:

• Outline settings

• Interior settings

• Shadow settings

• Background settings

Manipulating these settings allows you to create various text ef fects. See example below:
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Placing a Speech Balloon Object

A Speech Balloon is a text frame in the form of a balloon. Speech Balloons are placed in docu-
ments to add visual interest. DesktopPublisher Pro has 12 types of balloons you can use when creating
a Speech Balloon object. 

The Speech Balloon tool on the Tool Palette places a Speech Balloon object on a document.
The procedure for object creation is the same as described previously . The Speech Balloon object
behaves like a text frame. The Text tool automatically activates, allowing you to modify text you
are going to enter. All the options available in DesktopPublisher Pro for WORKING WITH TEXT (see the
corresponding section above) are valid for Speech Balloons also, except for Linking and Unlinking
Text Boxes. For example, the default text alignment of the balloon objects is Center , but you can
easily override this setting using the Alignment buttons from the Text tool, or the Alignment sub-
menu of the Text menu. 

To switch balloon types, select a Speech Balloon with the Object tool and double click on it. 
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The Speech Balloon dialog box contains a group of Balloon Type buttons, and two check boxes
for changing balloon orientation. Change Orientation check boxes affect the balloon graphics only,
not the Speech Balloon text. 

The picture above shows the Speech Balloon object after setting the new balloon type, line style,
line width, line color, fill color and pattern. All this can be easily accomplished by using the Frame
Info and Fill Info dialogs boxes.

Speech Balloon object text can run around the overlayed objects as any text in a usual Text Box.
But in contrast to Text Boxes, this setting is off by default. To make Speech Balloon text runaround
overlapping objects, select Object Info from the Object menu, and check the Text Runaround
check box.

You can also access the Text Box information dialog box from a Speech Balloon by selecting the
Speech Balloon object with the Object tool, and then double clicking on it with the Shift key
pressed.
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The picture below shows an example of using a Speech Balloon object in your document:

Placing a Bezier and Bezier Text Objects

Bezier curves are placed on documents with the help of the Bezier tool from the Tool
Palette. To create a curve, select the tool from the Tool Palette. Click in the position where you want
to locate the starting point of the curve, then release the mouse, and move it to a new position. The
current curve will be drawn all the time you move the cursor . Click and move the mouse to a new
location again. 

Repeat the process until the curve is completed, then make a double click with the mouse. The
Bezier tool will deactivate then, and the Object tool will become active.
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To add color, style, and other attributes to the curve, use the Graphics menu options.

The Bezier Text tool makes it possible to display text along Bezier curves. After you create a new
curve as described above with the Bezier Text tool, you are presented with the Bezier Text dialog
box.

It allows you to add text, and change some text attributes, such as Font, Font Size, Color, and
Shade. Make the desired settings and click OK.

You can modify the existing curve. Select it, and then activate the Bezier tool from the Tool
Palette. The curve is then presented to allow reshaping.

104

Desktop Publisher Pro by Cristallight 



The two types of the control points indicated by the solid dots and empty rectangles. The dots are
the on-curve points, and dragging them repositions the portion of the curve they are located on. The
rectangles specify the of f-curve control points. Moving them to a new position changes the direc-
tion of the curve. 

Adding Colors to a Document

DesktopPublisher Pro allows you to create, edit and delete colors present in DesktopPublisher Pro docu-
ments. When starting the application and creating a new document, all the color menus display the
eight basic colors. These colors can not be edited or deleted. 

Use the Create Color button on the Edit toolbar , or the Create Color command from the
Edit menu, to modify the colors that are used in the current document.

Selecting Create Color activates the Create Color dialog box that allows you to create new col-
ors, and edit or delete existing ones if they are no longer needed. 

105

Desktop Publisher Pro by Cristallight 



To add a new color: click on the Add button. This adds a new color to the list, and then presents
you with the standard Macintosh Set Color dialog box:

After selecting the desired color, the color list is immediately modified to reflect the change. The
new color name can be assigned or modified using the Color Name edit field under the Colors list
in the Create Color dialog box.

To delete a color: select the color, and then click on the Remove button.

Any changes to the number of colors, and the colors themselves are immediately reflected in the
Line Color, the Text Color, the Fill Color, and the Background Color menu entries.

Adding and Deleting Pages

The maximum number of pages in a DesktopPublisher Pro document can be increased up to 999.  To
add pages the Insert Page command from the Page menu is used. It inserts the specified number of
copies of the currently selected Master Page (see later in this manual) into a document. If the doc-
ument was created with the Automatic Text Box option, inserting pages links the automatic Text
Boxes on a newly created pages to the automatic boxes on the existing ones, thus extending the
existing text chain.
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The dialog box contains:

• The Insert Pages edit field. It is used to specify the number of pages to be added to a doc-
ument.

• The Location pop-up; It may be After Page, Before Page, or At End of Document. If
either of the first two options is selected, the edit field to the right of the pop-up displays the
number of the page before or after which a new page is to be added.

• The Master Page pop-up menu allows you to select a Master Page for your newly created
pages. It contains a list of the Master Pages currently available for the active document. 

• The Link to Current Text Chain check box allows you to link the automatic Text Box on the
newly created page to the currently active Text Box. This option is available when the
Automatic Text Box setting from your Document Setup dialog box is on, and the Text tool
is selected.

Deleting pages is controlled by the Delete Page dialog box. It allows you to select a range of
pages to be deleted.

Text in text chains on deleted pages is reflowed through the remaining elements of the chains,
unless all elements of the chain are deleted, in which case the entire chain is deleted.
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Master Pages Support

DesktopPublisher Pro, in addition to regular document pages, supports Master Pages. Master Pages
are page templates, used for creating regular document pages. Master Pages may contain various
objects, and these objects are automatically added to a new document page created from Master
Pages. 

You can display or hide Master Page objects on the document page. The Show Master Pages com-
mand from the Page is used for doing this. If it is checked and you still do not see the Master Page
items, make sure they are not being covered by another object. 

The Master Items in Front check box from the Preferences dialog box controls how Master Page
items are displayed - above or under all document page objects.

To create a new Master Page: use the Create New Master Page dialog box. 

It allows you to type in a name for a new page, to specify the number of columns and set the
Margin distances (used for displaying Margin Guides on a page). Selecting the Two Page radio but-
ton allows you to create Double Sided Master Pages for double sided documents. 

To delete a Master Page: use the Delete Master Page option. The corresponding dialog box allows
you to select the Master Page to be deleted.

To view a particular Master Page: use either the Go To Page dialog box, or the page Navigation
buttons, located on the right of the Controls Area at the bottom of the Document Window. 
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To select or change the Master Page of a particular document page, use the Left and Right Master
Page pop-ups, located to the right of the View Size pop-up in the Controls Area.

Left and Right Master Page controls contain pop-up menus with a list of all the Master Pages,
available for your document. The list is updated when you add, edit or remove Master Pages using
the Create Master Page, Master Page Options, and Delete Master Page menu commands from the
Page menu.

The Left Master Page pop-up is enabled when the document is double sided, that is the Double
Sided Pages check box from the Document Setup dialog box is checked. 

Document Navigation

The Previous and the Next Page buttons on the bottom of the Document Window are used for
navigating through your document. Clicking on the Previous Page button displays the previous
page. If the first document page is displayed, clicking on the Previous Page button displays the last
Master Page from the Master Pages list. Subsequent clicking on this button navigates you through
the list of currently available Master Pages. 

If there are no more pages before or after the current one, the Previous/Next buttons become dis-
abled.

The Page Number indicator and Go To Page control allow you to display a particular page of your
document. Clicking on it displays a pop-up menu for the desired page number selection. 

The Go To Page menu option from the Page menu is also available. 

Page Numbering

Use The Page Numbering command to place the page numbers on the document pages.
DesktopPublisher Pro allows you to display page numbers on pages 

• in various formats

• in various locations on the page

• using various offsets from the page edges

• starting from the specified page number

• using any style sheet available in the current document
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To customize page numbering, select the corresponding menu option from the Edit menu, and the
dialog box appears.

• Prefix — up to four characters can be entered to precede the page number (for section, etc.). 

• Number — the page sequence number. 

• Format — the format of the page sequence number . This includes: 

- 1,2,3,4 Numeric 
- I,II,III,IV Upper case Roman 
- i,ii,iii,iv Lower case Roman 
- A,B,C,D Upper case Alphabetic 
- a,b,c,d Lower case Alphabetic 

• Center / Right radio group - centers the page number or shifts it to the right of the page, 

Note: for double-sided pages, setting Right places the page number of the right page on its
right side, of the left page - on its left side,

• Top / Bottom radio group - places the page number on the top or on the bottom of the page, 

• Margin Page Numbering - specifies of fsets from page edges. These settings can be cus-
tomized if the check box is on,

- From Top - specifies the page number of fset from the top edge of the page;
- From Right - specifies the page number of fset from the right edge of the page;

• Style pop-up defines the Style Sheet used for page numbering.
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Using Document Preferences

There are a number of document settings which specify the behavior of DesktopPublisher Pro when
working with documents. All of them are grouped in the General panel of the Preferences dialog
box. 

To access these settings use the Preference option from the Edit menu. Here is a short description
of the attributes:

• Show Master Page - displays the Master Page items on pages created from Master Pages. 

• Master Items in Front - switching this option on makes the objects, located on the Master
Page that is associated with the current document page, overlay the document page items.
Otherwise the Master Page items underlay all the objects located on the page.

• Color - defines Margin Guides and Ruler Guides colors. You can change any of these col-
ors by clicking on the corresponding button and selecting a new color from the standard Set
Color dialog box.

• Scrolling - changes the document scroll unit. Moving the Scrolling slider toward Fast
increases the scroll speed, toward Slow decreases the scroll speed.

• Guides in Back - when checked, makes the document guides underlay all the other objects
on a page.

• Auto Save Every … minutes - when checked, saves the current document once in the spec-
ified period of time.

• Save Page Scale - when checked, saves the page scale when saving a document. Opening
the document next time displays it in the scale used on saving.
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• Store Graphics in Documents - saves a copy of all the picture graphics with a
DesktopPublisher Pro document. Moving the document from one location to another on your
hard drive won’t affect the picture graphic. This increases document size by the size of the
picture graphics.

• Pasteboard Height and Width - defines dimensions of the pasteboard in percents relative
to the vertical or horizontal page size.

• Horizontal/Vertical measures - sets default measurement units for new documents.

Changing these attributes is valid for the current document only . They can be made the
DesktopPublisher Pro defaults by clicking the Make Default button. Then each new document will have
these preferences right after creation. 

The Text settings are explained in the Text Preferences section earlier in this manual.

Predefined Document Templates

DesktopPublisher Pro allows you to create ten types of documents with predefined layouts. Such doc-
uments are called Templates. Custom templates can be created and added to the Templates folder.

Select New from the File menu, then use the Create Document From Template option from the
New Document dialog box. You are presented with the Select Template dialog box. All available
DesktopPublisher Pro templates are displayed and can be previewed and edited, i.e. filling the picture
and Text Boxes contained in templates with the desired contents.
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• Hierarchical Template List box, which displays all the predefined templates distributed
with DesktopPublisher Pro by categories

• Template Preview area, that shows the preview of the current template and allows you to
select text and Picture Boxes to fill them with contents

• Navigation controls, allow you to navigate through template pages

• Preview Template check box, switches the Template Preview area from displaying the
boxes with text and picture contents to just box outlines, to show the template layout

• Place Text button, that becomes active when a Text Box is selected in the Preview area

• Place Graphics button, that becomes active when a Picture Box is selected in the Preview
area

Before you can start working on the predefined document template you must select and open it.
To create a document from template, select the desired template from the Hierarchical Template
List. 

If you want to fill in pictures and text later , just click on the Done button to start working with
the newly created document. Sometimes it’ s easier to work with the document in the Actual size.
Otherwise, click on the Template Preview area. This replaces the picture preview by the real text
and Picture Boxes. Select the desired text /picture object, and click Place Text/Picture button, or
double click on the object. If the template has more then one page, use the navigation buttons to
switch between pages. 

Saving a Document

After modifying the document you may want to save the changes you have made to a file. It is a
good practice to periodically save your documents to avoid losing any work if should your computer
lose power, or your system crash.

You can save your documents by using the Save option from the File menu. It is dimmed until
you've made changes that need to be saved. 
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You are able to save your document either as a regular DesktopPublisher Pro document or as a tem-
plate document, discussed in the previous section of this manual. This choice is available when you
are saving a document for the first time using the Save option, or saving the already existing docu-
ment under another name using the Save As option. In both cases the Save As dialog box is dis-
played. 

• Select the location on you hard drive for the document to be saved, 

• Enter a name for your document into the Name edit field unless you want to accept the sup-
plied name,

• Select the format of the document from: 

- DesktopPublisher Pro Publication
- AutoCreate template

Selecting AutoCreate Template automatically reroutes you to the Templates folder, where
all the DesktopPublisher Pro templates are stored. If you do not want the template to be stored
there, navigate to another location using the files list,

• Check the Create Preview box to store the picture preview of the document along with it. 

• Click the Save button to confirm changes.

Exporting Documents

In order to be able to use the information stored in DesktopPublisher Pro document files with the
other applications, DesktopPublisher Pro allows you to export documents in two formats:

• As Text files

• As HTML files
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When using the Export as Text option, all the text contained in the active document is saved into
a text file, and then is stored on your hard drive in the location you specify . 

Exporting as HTML is dif ferent. The entire text, contained in the document, is saved as the
HTML page. All the graphics and Picture Boxes are saved as picture images in GIF format, and the
links to them are inserted into the HTML file. Opening it with a web browser will display the rep-
resentation of the document with, however, changes imposed by the HTML format specification. 

Printing a Document

Selecting Print from the File menu activates a dialog box that initiates printing of the active doc-
ument. The set of printing options contained in the dialog box depends on the type of printer you
select (via the Macintosh Chooser). DesktopPublisher Pro adds more options, giving a user more power
and flexibility when printing documents. These options are grouped in the Print Options dialog box.
To access it, select the Print Options menu item from the File menu.

The elements of the dialog box:

• Print All, Odd, or Even pages. This is convenient when it is necessary to print on both sides
of the paper. The document is then printed in two passes, first with Only Odd Pages set,
and second with Only Even Pages selected.

• Centering Page - if the document format specified in the Document Setup dialog box does
not correspond to the paper format used, then the document pages will be centered on the
paper.

• Reverse Order - prints your document in the reverse order. Check the corresponding check
box to start printing your document from the last page.
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• if the paper size is lar ger then the page size of a document, it is reasonable to use the crop
or trim marks when printing. When Trim Marks is checked, then the rectangle showing the
document page edges is printed on the output. 

The Crop Marks are the horizontal and vertical lines, indicating the page area.

• Print Spot Color Separations. This option prints an individual sheet for each color used
within the document. 

• Automated Tiling is used for printing large documents on smaller paper. Specify an over-
lap value in the Overlap field.
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Menu Structure Reference
This section describes the menu structure available in DesktopPublisher Pro. Each menu item is

explained. You can also find information on the menu structure in the DesktopPublisher Pro on-line
help.

File Menu

The File menu includes the commands allowing you to manipulate DesktopPublisher Pro documents,
import text and graphics into them, export, and change document and printing settings. It also allows
the user to print a document, and exit DesktopPublisher Pro.

• New…
- Create Document From Scratch
- Create Document From Template

• Open…
• Close
• Save
• Save As…
• Import Text…
• Import Graphics…
• Export Document
• Document Setup…
• Print Options…
• Page Setup…
• Print…
• Quit
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New

The New command enables you to create a new document window . When New is selected from
the File menu, the New Document dialog box appears with the two options:

• Create Document from Scratch

• Create Document from Template

Select the desired option and click OK.

Create Document From Scratch

When you select the Create Document Fr om Scratch option from the New Document dialog
box, you are presented with the Document Setup dialog box that allows you to set the attributes of
the new document. These attributes include:

• Page Size - the size of the document’s page. This can range from as small as 1" x 1", to as
large as 18" x 18" (for facing-page documents) or 36" x 36" (for single - sided documents). 

US Letter 8 1/2" wide, 11" tall (default setting) 
US Legal 8 1/2" wide, 14" tall 
A4 Letter 210 mm wide, 297 mm tall 
B5 Letter 182 mm wide, 257 mm tall 
Tabloid 11" wide, 17" tall 
Other size specified by Width and Height  

• Units - the measurement units for all the numerical information in the dialog box. It speci-
fies also the units displayed on the rulers, when a document is created.

• Margin Guides - the distance from the page guides to the edges of the paper . Margins are
preset to 1/2" on top and bottom and to 0.7” on left and right sides.

• Double Sided Pages - can be used to create a document with two dif ferent Left and Right
pages. In this case the Mar gins indicate Inside/Outside versus Left/Right, and the docu-
ment Master Pages can be set up with left and right page components. 

• Pages - defines the number of the starting page and the number of pages in a document. 

• Column - defines columns for the original Master Page and the first page of the document. 

• Number - defines the number of columns.

• Spacing - changes the distance (or gutter) between columns.

• Automatic Text Box - if it is checked, the original Master Page and first page of the docu-
ment will automatically contain a Text Box having the specifications defined by the Page
Size, Margin Guides and Column Guides.
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Create Document From Template

When the Create Document Fr om Template option from the New Document dialog box is
selected, you are presented with the Select Template dialog box. It shows all available DesktopPublisher
Pro templates and allows previewing and editing of them, i.e. filling the picture and Text Boxes con-
tained in templates with the desired contents. 

The dialog box contains:

• Hierarchical Template List box

• Template Preview area

• Navigation controls, for navigating through the selected template pages, in case the tem-
plate it has more then one page

• Preview Template check box

• Place Text button

• Place Graphics button

To create a document from template, select the desired template from the Hierarchical Template
List box, then click on the Template Preview area. This replaces the picture preview with the real
Text and Picture Boxes. Select the desired text/picture object, and click Place Text/Picture button
or double click on the object. If the template has more then one page, use the navigation buttons to
switch between pages.

Unchecking the Preview Template check box switches to showing just the location of the objects
on a page, not their contents.

Open

Use the Open command to retrieve an existing document or template from disk. It also allows
you to preview a file in a preview box which is activated by using the preview option.

Open activates a dialog box which allows you to select the file to be opened. Up to 10 documents
or templates can be opened at any one time. The Open dialog box by default displays All Types of
DesktopPublisher Pro files. 

To open a document/template, select a name from the file list, and click Open or double click on
the file name.

Close

The Close command closes the current document and removes it from the desktop. If the docu-
ment has been changed since it was either opened or last saved, you will be prompted to save it
before it is closed. If it is not saved before closing, any changes made will be lost.
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Save

Use Save to save the changes you have made to a file. The Save option is dimmed until you've
made changes that need to be saved. If you are saving a new document, the Save As dialog box is
displayed. Enter a name for your document unless you want to accept the supplied name and click
Save.

Note: It is a good idea to periodically Save your work in any application, including DesktopPublisher
Pro. This ensures that your work will not be lost in the event of a power failure, system malfunc-
tion, etc.

Save As

Use Save As to create a new template from the open document, or to rename a document, there-
by making a duplicate of it. When you select Save As from the File menu, a dialog box appears that
allows you to specify the new name and the format for the file that will contain the document.

You can save your document in two formats:

• DesktopPublisher Pro Publication - DesktopPublisher Pro’s own format

• Auto Create Template

Import Text

Use Import Text to import text into DesktopPublisher Pro. Text can also be pasted into documents
from the Scrapbook desk accessory and the Clipboard. 

The Text tool must be currently selected in order to use Import Text. Standard TEXT files can
be imported into DesktopPublisher Pro without any additional support. Other formats require MacLink
Translators or other translation extensions to be installed on your computer . 

The text is inserted at the text insertion point or replaces the currently highlighted range. 

To import text, select a name from the file list, then click Open, or double click on the name. 

Import Graphics

Graphic objects are imported using the Import Graphics command. When you select Import
Graphics from the File menu, a dialog box appears that allows you to specify the file from which
the graphic is to be imported. DesktopPublisher Pro can accept graphics in a variety of di fferent 
formats.

120

Desktop Publisher Pro by Cristallight 



If the Translation Manager is installed on your system, and there is at least one graphic translator
(QuickTime, etc.), then DesktopPublisher Pro uses all the translation options available in that case.
Otherwise, only six graphic formats are accepted, including: 

• MacPaint format graphics 

• PICT format graphics 

• Encapsulated PostScript® (EPS) graphics 

• Tag Image File Format (TIFF) images 

• GIF images 

• QuickTime (Cmd - Option -click to play a QuickT ime movie, click on the playing movie
to stop).

If Picture Preview is checked, a representation of the picture is displayed when you select its
name in the file list. 

To determine the Type and Size of a file: Click once on its name. 

To import a picture, select a name from the file list, then click Open or double click on the file
name. 

Note:a picture is imported into the active Picture Box. If you want to import it into a new Picture
Box, make sure that no Picture Boxes are active. 

Export Document

Use Export Document to save your document either in the TEXT format or as an HTML file. 

If you select Export as Text, all or the selected portion of the story in the active Text Box (or
chain of linked Text Boxes) will be saved to a file, without any page layout information. Text is
saved as ordinary ASCII text. 

To save the text of the current text chain: Supply the output file name for the text in the field
labeled Save Text As. Choose either Selected Text (if a range of text is highlighted) or Entire Text
Chain, and click Save. 

To save the document as an HTML file: Supply the output file name for the HTML document in
the field labeled Save Text As, and select the folder in which to save your files. Your document is
saved as a collection of graphic files representing all of the graphics used in your document and one
HTML file.
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Document Setup

Use Document Setup to change the page size of the active document or to switch between a sin-
gle-sided and facing-page document. 

• When a new document is created, page mar gins are defined by the Page Size and Margin
Guides specified in the New dialog box.

• If Automatic Text Box is checked, an automatic Text Box coinciding with the page mar-
gins is created on the first page of the document and on the original Master Page. 

• Double Sided Pages switch the document layout between double-sided and single-sided.
The double-sided page document may have double-sided Master Pages.

Print Options

Selecting Print Options from the File menu activates the Print Options dialog box. This allows
you to specify the method of printing of the active document. It allows you to:

• Print All, Odd or Even pages. Click on the correspondent radio group button to select one
of these options.

• print your document in the reverse order. Check the corresponding check box to start print-
ing your document from the last page.

• Use Crop and Trim Marks when printing. When Trim Marks is checked, then the align-
ment marks are placed on the edges of the output. Checking the Crop Marks box allows
you to print the crop marks (horizontal and vertical lines, indicating the page area) if the
paper size is larger then the page size of a document.

• Print Spot Color Separations. This option prints an individual sheet for each color used
within the document. 

• Automated Tiling is used for printing large documents on smaller paper. Specify an over-
lap value in the Overlap field.

Page Setup

Use Page Setup to control how a document is printed. The Page Setup dialog box corresponds
to the printer you are using and reflects the options for your printer . Options specific to one printer
are noted as such. 
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Some common options are these:

• Paper - the size of the paper on which to print the document. The options are: 

US Letter 8 1/2" wide, 11" tall 
US Legal 8 1/2" wide, 14" tall
A4 Letter 210 mm wide, 297 mm tall
B5 Letter 182 mm wide, 257 mm tall
Tabloid 11" wide, 17" tall
International Fanfold 8 1/4" wide, 12" tall

• Reduce or Enlarge (LaserWriter)- allows output reduction down to 25% or enlargement up
to 400%.

• Orientation - determines whether the document is printed on the paper horizontally or ver-
tically.

• Font Substitution - substitutes an appropriate built-in font for certain Macintosh screen
fonts.

Print

Selecting Print from the File menu activates the Print dialog box that initiates printing of the
active document. The specific contents of this dialog box depend on the type of printer you have
selected (via the Macintosh Chooser). Typically, edit boxes will appear that allow you to select the
number of copies, along with a variety of other options which are specific to your printing device.
It may include:

• Copies - the number of copies to print. 

• Pages - specifies the page range you want to print (unless you want to print the entire doc-
ument). Absolute page sequence numbers must be preceded by a plus “+” sign. If a Master
Page is currently displayed in the document window , Pages is unavailable and the current
Master Page is printed. 

• Cover Page - prints a cover page for the document (either the first or the last page). 

• Paper Source/Feed - click Paper Cassette or Automatic for standard paper feeding. Click
Manual Feed or Hand Feed for separate sheets of paper(for example, letterhead). 
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• Quality - Best prints highest quality, but it is slowest. Faster prints standard quality, but it
is faster. Draft quality is lowest, (prints only text) but it is the fastest. 

• Destination - click Printer to output the document to a printer . Click PostScript® File to
create a PostScript file of your document. 

• Page Sequence - choose All, Even, or Odd from the Page Sequence pop-up menu to print
all pages, only the even pages, or only the odd pages in a document. When more than one
copy is requested, Collate will print successive copies of the complete range of pages, rather
than a number of copies of each page in the range. Checking Back to Fr ont prints the
selected range of pages in reverse order. 

• Output - Normal produces full standard output. Low Resolution prints pictures at low res-
olution. Rough is faster but substitutes a plain frame for fancy frames and doesn’t print pic-
tures. 

• Tiling - used for printing large documents on smaller paper. Specify an overlap value in the
Overlap field. 

• Separation - prints an individual sheet for each color used within the document. All plates
or a specific separation plate can be chosen for the Plate pop-up menu to print. 

• Registration - places alignment marks on the edges of the output. These marks can be
Centered or Off Center. 

• Print Colors as Grays - causes colors to be printed as grays that correspond to the color ’s
brightness instead of as 100% black. It is only ef fective when you aren’ t color separating
and when you aren’t printing on a color PostScript printer . 

• Include Blank Pages - Checking Include Blank Pages prints pages containing no printable
items. 

Note: The progress in downloading a job to a PostScript printer will be monitored in the Print
Status dialog box when you click Print. Information displayed includes the current page, separation
plate, title and picture being processed. You can prevent the Print Status dialog box from appearing
by holding down the Shift key when clicking Print. 

Quit

The Quit option exits a DesktopPublisher Pro session. If you quit without saving a new document or
changes to an existing document, DesktopPublisher Pro asks you if you want to save the changes. Click
Yes to save or No to discard your changes. Cancel will abort the Quit command. 
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Edit Menu

This menu contains the next options: 

• Undo/Redo
• Cut
• Copy
• Paste
• Clear
• Select All
• Editions
• Show Clipboard
• Find/Replace Text…
• Enter Find String
• Find Next
• Replace
• Replace & Find
• Replace All
• Find/Replace Style…
• Edit Style Sheets…
• Edit User Dictionary…
• Create Color…
• Edit Toolbars…
• Ruler Settings…
• Guides Settings…
• Page Numbering…
• Preferences…
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Undo/Redo

Undo reverses the last change made to the document. Redo reverses the effect of the most recent
Undo. Undo applies to a variety of actions, some of which are on menus other than the Edit menu.
Undo appears shaded if the most recent action cannot be undone. After choosing Undo, the com-
mand becomes Redo.

Cut

Cut removes a selected object or a text selection from the document and places it on the
Clipboard. 

The operation of Cut is possible with either the Object tool or the Text tool selected. 

The object remains on the Clipboard until something else replaces it. 

To cut an object: Activate the item with the Object tool and choose Cut. 

If the Text tool is selected, use Cut to remove the highlighted text in a Text Box and place it on
the Clipboard. 

To cut text: Highlight the text with the Text tool selected, and choose Cut. 

Paste subsequently can be used to place the text or picture residing on the Clipboard elsewhere
in the active document or in another document or application.

Copy

Copy places a copy of the selected object or a text selection on the Clipboard. The operation of
Copy is possible with either the Object tool, or the Text tool selected. 

The object remains on the Clipboard until something else replaces it. 

To copy an object: Activate the item with the Object tool and choose Copy. 

If the Text tool is selected, use Copy to create a duplicate the highlighted text in a Text Box and
place it on the Clipboard. 

To copy text: Highlight the text with the Text tool selected, and choose Copy. 

Paste subsequently can be used to place the text or picture residing on the Clipboard elsewhere
in the active document or in another document or application.
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Paste

Paste copies the contents of the Clipboard to the document without altering the Clipboard. The
Clipboard may contain text, graphics objects, pictures, or a combination of these. The contents may
have resulted from commands used while working with other applications. For example, this pro-
vides a means by which objects and text can be transferred to DesktopPublisher Pro from other appli-
cations and vise versa.

Clear

Clear deletes an item, such as text or a graphics object without making a copy of it on the
Clipboard.

Select All

Select All activates all items on a page, or highlights all text in linked Text Boxes. 

The operation of Select All depends on which tool is currently selected. If the Object tool is cur-
rently selected, Select All activates all objects within the current page. If the Text tool is currently
selected, Select All highlights all text within the active text chain. 

Select All is dimmed if the Object tool is selected and there are no items on the current page, or
if the Text tool is selected and no Text Box is active.

Editions

The Editions command is used to control subscription to another document. Selecting and hold-
ing mouse button on Editions from the Edit menu activates a submenu. This submenu provides two
options, each of which activates a dialog box. The Subscribe To selection dialog box allows you to
specify a document to which you wish to subscribe. The Subscriber Options dialog box is used to
specify the attributes of a subscription, including timing of updates, and cancelling of a subscrip-
tion.

A full description of the subscription process can be found in the Macintosh System documenta-
tion.
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Show Clipboard

Use Show Clipboard to display the Clipboard window. If the Clipboard is already displayed but
is behind other windows, Show Clipboard brings it to the front. 

The Clipboard contents are determined by the last Cut or Copy that was performed. You can’t
edit in this window.

Find/Replace Text

Selecting Find/Replace from the Edit menu activates the Find/Replace dialog box that allows
you to search the document for specific text or a pattern of text using special characters. Use
Find/Replace to search for and selectively change specific text strings. Choosing Find/Replace
displays the Find/Replace dialog box.

The following options are available: 

• Whole Word — finds only occurrences that are distinct words (not embedded in other text).
For example, if you search for “the,” the will be found, but not “their” or “other.” If Whole
Word is unchecked (default setting), any occurrence of the specified text, regardless of its
position within other text, is found. 

• Ignore Case — (default setting) finds any occurrence of the specified text, regardless of its
capitalization. If Ignore Case is unchecked, the exact capitalization as entered must be pre-
sent. 

To find text: Enter the text you want to find in the field labeled Find What. Enter the replacement
text in the Change to field. Leave this field blank if you want to search for (but not change) spe-
cific text, or if you want to delete the searched text. Position the text insertion point where you want
the search to begin. The buttons on the bottom of the Find/Replace dialog box control the search
and changes: 

• Find Next — begins the search or finds the next occurrence of the specified search criteria. 

• Replace — changes the highlighted text. 

• Replace All — changes all occurrences of the search criteria. An alert is displayed showing
the number of occurrences changed. 

Enter 'Find' String

This option becomes active when some text is highlighted. When selected, the Enter Find String
copies the highlighted range to the Find What field of the Find/Replace Text dialog box.
Consecutive use of Find Next, Replace & Find, and Replace All commands allows you to modi-
fy text without displaying the Find/Replace Text dialog box.
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Find Next

Find Next either begins the search, or finds the next occurrence of the search criteria, specified
in the Find What field of the Find/Replace Text dialog box. 

Replace

The Replace command replaces any currently selected text with the contents of the Replace
With edit field of the Find/Replace dialog box. 

Replace & Find

Replace & Find is equivalent in action to the consecutive selection of the two commands -
Replace, and Find Next. 

Replace All

Replace All searches the entire text in the current text chain for the current searching criteria -
the contents of the Find What edit field from the Find/Replace Text dialog box, and replaces it with
the contents of the Replace With edit field. 

Find/Replace Style

Selecting Find/Replace Style from the Edit menu activates the corresponding dialog box which
allows you to search the document for styles used. Use Find/Replace Style to search for and selec-
tively change specific text strings.

• The Font and Size pop-ups and the group of Face check boxes define the searching crite-
ria. To make the search possible you need to specify at least one of these attributes in the
left side of the dialog box.

• The buttons on the right of the Find/Replace Style dialog box control the search and
change: 

- Find Next - begins the search, or finds the next occurrence of the specified search cri-
teria. 

- Replace - make changes specified by the Change to column. 
- Replace All - changes all occurrences of the search criteria. An alert is displayed show-

ing the number of occurrences changed. 

Edit Style Sheets

Use Edit Style Sheets to make new custom style sheet definitions or to change existing custom
style sheets in a DesktopPublisher Pro document. 

To define style sheets for a specific document: Choose Edit Style Sheets when the document is
active. The style sheet definitions you make are saved with and will be used with that document. 
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To create a new style sheet: Click New, and the New Style dialog box is displayed. Use this dia-
log to create the new style sheet: 

• Name - the name by which the style sheet is referenced. 

• Next Style - the style sheet that will be applied when a carriage return is used while typing. 

• Character, Paragraph, Rule above, Rule below and Tabs - display dialog boxes in which
the style sheet attributes can be specified. 

To change an existing style sheet:Select a custom style sheet from the list and click Edit or dou-
ble-click on the style sheet name. Changes are made in the same manner as described above for cre-
ating a new style sheet. 

To create a style sheet from an existing style sheet:Select a custom style sheet from the list, and
click Duplicate. This creates a copy of the style sheet. Using the this copy , make changes the way
described above for editing a style sheet. 

To delete a style sheet: Select a custom style sheet from the list, and click Delete. Note that the
Normal style sheet can’t be deleted. 

To add style sheets from another DesktopPublisher Pro document: Click Append and select the doc-
ument whose style sheets you want to add. When Appending style sheets, an alert is displayed if
the source document has a style sheet with the same name as a style sheet in the tar get document.
You may append the style sheet with the same name by clicking Rename New Style. 

To save changes made to style sheets: Click Save, and the changes made to style sheets for the
active document or the DesktopPublisher Pro application are updated. 

To discard your changes: Click Cancel. All changes you have made to style sheet definitions,
since you chose Style Sheets, are discarded.

Edit User Dictionary…

When spell-checking a document, DesktopPublisher Pro verifies all the words in it by scanning the
100,000-word DesktopPublisher Pro “Main Dictionar y,” and then the User Dictionar y. If the program
finds no match in both dictionaries for the word being verified, it indicates an error . Customizing
dictionary contents enables you to accomplish better spell checking.

Updating the User Dictionary contents may be done in two ways: 

• Select the Edit User Dictionary… command from the Edit menu. This displays the User
Dictionary dialog box that allows you to edit the DesktopPublisher Pro User Dictionary. It con-
sists of the list of the words showing in the current contents of the dictionary , an edit box
for entering new words, and control buttons.

To add a new word to the DesktopPublisher Pro User Dictionary: type in the word and click on
the Add or the Full Add buttons. If the Add button is used, then the word is immediately
added to the dictionary. Otherwise, you are presented with the Add to Dictionary dialog box,
containing various suffixes you may add to the word.
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To remove a word from the dictionary: select it in the list box and click on the Remove but-
ton.

• From the Spell Checking dialog box. 

Add command adds current contents of the Replace With edit field. If the edit field is
empty, or the word is already present in the dictionaries, the Add button is disabled.

Full Add presents you with the Add to Dictionary dialog box, containing various suf fixes
you may add the word with. 

The Remove command removes the word currently selected in the dialog word list. 

Create Color…

The Create Color… command is used to modify the colors that are used in the current document.
Selecting Create Color… from the Edit menu activates the corresponding dialog box that allows
you to create new colors and edit or delete existing ones if they are no longer needed. 

The Create Color dialog box contains the Add, Remove, and Set buttons and the list of the col-
ors existing in the currently active document.

The list always contains the eight basic colors that are present in DesktopPublisher Pro and are the
same for all the documents. They can not be edited or deleted. 

Any changes to the number of colors or the colors themselves are immediately reflected in the
Line Color, the Text Color, the Fill Color, and the Background Color menu entries.

Edit Toolbars…

Selecting Edit Toolbars… from the Edit menu activates the corresponding dialog box which
allows toolbars to be modified. Toolbars can be created, deleted or customized. Toolbar visibility
can be controlled and toolbar elements can be added, removed or reordered. You are also able to edit
toolbar names, and switch the toolbar hints on and of f.

The dialog contains the Toolbars List box, the New, Delete, and Customize buttons, the Show
Hints check box, and the Toolbar Name edit field.

• The Toolbars List - contains the names of all the toolbars currently available, along with
the check boxes to the left of the names, representing the corresponding toolbar ’s visibility.
To show/hide a toolbar, click on the check box in the Toolbar List. 

• New - adds a new toolbar to DesktopPublisher Pro. Clicking on the button creates a new tool-
bar window. It is immediately shown in the Toolbar List, and its name is displayed in the
Toolbar Name edit field.

• The Delete button - permanently removes the selected toolbar from Mac Publisher Pro.
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• Customize - displays the Customize dialog box, containing the toolbar elements sorted by
functional categories, where you can edit the toolbars. To edit, select the desired toolbar ele-
ment from the Customize dialog box and move it to the desired location on a toolbar . You
are also able to remove any element from the toolbar just by dragging the element out of it;
reorder the toolbar elements on a toolbar by dragging them to new positions.

• Show Hints. When this option is on, placing the cursor over a toolbar element causes a
description of its function to be displayed.

• The Toolbar Name edit field contains the name of the toolbar that is currently selected in
the Toolbar List. Edit the name of the toolbar as you see fit.

Ruler Settings…

The Ruler Settings… command is used to change which units are used on the rulers shown along
the left side (vertical ruler) and at the top (horizontal ruler) of the Document Window. Different units
can be displayed for the horizontal and vertical rulers. 

When Ruler Settings… is selected from the Edit menu, a dialog box appears which allows you
to set individual ruler measurements. The available units are: inches, picas, points, and centimeters.

Ruler settings can also be changed by clicking on the units displayed at the intersection of the two
rulers.

Guides Settings…

The Guide Settings… command is used to the specify the guide settings. When Guide
Settings… is selected from the Edit menu, the Guide Settings dialog box appears that allows you
to change the guide frequency for both horizontal and vertical guides, the units of measure for the
guides, whether or not the guides are to be displayed, and whether or not objects are to be snapped
to the guides.

• Guide Frequency places guides on the page at a predefined distance

• Units - specifies the distance measurement units

• Show Guides check box - makes the guides visible, acts like the Show Guides option in
the Page menu

• Snap to Guides check box - forces the location of a selected item location to depend on the
guides, acts like the Snap to Guides option in the Page menu

The Guide Settings are saved with the current document and are valid the next time the document
is open.
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Page Numbering…

The Page Numbering… command is used to change the page numbering sequence or format for
the current page. To specify a page numbering, make changes as follows: 

• Prefix — up to four characters can be entered preceding the page number (for section, etc.)

• Number — the page sequence number

• Format — the format of the page sequence number . This includes:

1,2,3,4 Numeric 
I,II,III,IV Upper case Roman 
i,ii,iii,iv Lower case Roman
A,B,C,D Upper case Alphabetic
a,b,c,d Lower case Alphabetic 

• Center / Right radio group - centers the page number or shifts it to the right of the page cor-
respondingly. Note: for double-sided pages, setting Right places the page number of the
right page on its right side and on the left of the left page

• Top / Bottom radio group - places the page number on the top or on the bottom of the page
correspondingly

• Margin Page Numbering settings are available if the corresponding check box is checked

• From Top - specifies the page number offset from the top edge of the page

• From Right - specifies a page number of fset from the edge of the page

• Style pop-up defines the Style Sheet used for page numbering.

Preferences…

The Preferences… command is used to change various attributes of the running application. 

When Preferences… is selected from the Edit menu, the dialog box appears that allows you to
change these attributes. The changes become permanent and will af fect the operation of the appli-
cation when you work on other documents.
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Object Menu

The commands in the Object menu are used to control the construction and presentation of
objects in your document. The commands under the object menu are listed as follows:

• Object Info…
• Frame Info…
• Fill Info…
• Shadow Info…
• Text Runaround…
• Duplicate
• Replicate…
• Delete
• Group
• Ungroup
• Bring to Front
• Send to Back
• Shuffle Forward
• Shuffle Backward
• Nudge Up
• Nudge Down
• Align objects…
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Object Info…

The Object Info… command is used to change the attributes of a Text Box, Picture Box, Line,
Graphic item, or group. A dialog box is displayed that allows you to change various attributes of the
selected object. The dialog box displayed depends on the type of object that was selected:

• Text Box Information

• Picture Box Information

• Graphics Item Information

• Line Information

• Group Information

When active objects are all of the same type (for example, all Text Boxes), choosing Object
Info…displays the corresponding specifications dialog box, (T ext Box Information). Fields con-
taining values that vary among active items are blank. Pop-up menus containing values that vary
among active items show mixed settings.

When active items are of dif ferent types (for example, Text Boxes and lines), choosing Object
Info…displays the Group Information dialog box. 

When an active set of objects contains a Group, Object Info…isn’t available. 

Text Box Information

The Text Box Information dialog box is displayed when one or more Text Boxes are active and
you choose Object Info… The following attributes can be changed: 

• Origin Across, Origin Down — repositions the upper left corner of the Text Box or the
bounding box around multiple Text Boxes. Values are relative to the current ruler origin. 

• Width, Height — changes the size of the active Text Box. Changing a box size doesn’t alter
its origin. These fields are unavailable when more than one Text Box is active. 

• Box Angle — rotates the active Text Box or the bounding box around multiple Text Boxes
around its center. Rotating a constraining Text Box rotates all constrained items as well. 

• Text Inset — specifies the space between text and the inner edges of active Text Boxes. 

• Printable - when unchecked, prevents from printing. 

• Locked - prevents an accidental replacing or moving of the object or Text Box.

• Visible - makes an object visible or invisible.

• Text Runaround - makes the text contained in the Text Box wrap around all objects which
overlap that Text Box. Text will only wrap around objects higher in "stacking" order .

• Units - indicates measurement units used for all the numeric information displayed.
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Picture Box Information

The Picture Box Information dialog box is displayed when one or more Picture Boxes are active
and you choose Object Info… The following attributes can be changed: 

• Origin Across, Origin Down — repositions the original upper left corner of the Picture
Box or the bounding box around multiple Picture Boxes. These values are relative to the
current ruler origin. 

• Width, Height — changes the size of the active Picture Box. Changing a box’ s size does-
n’t alter its origin. These fields are unavailable when more than one Picture Box is active. 

• Box Angle — rotates the active Picture Box, or the bounding box around multiple Picture
Boxes, around its center. Rotating a Picture Box rotates all items constrained within as well. 

• Offset Across, Offset Down — adjusts the distance between the original upper left corner
of active Picture Boxes and the picture each box contains. 

• Picture Angle — rotates the pictures in active Picture Boxes around each picture’ s center
(as determined by the application in which the picture was created), independent of its
Picture Box. 

• Scale Across, Scale Down — adjusts the size and proportions of the pictures in active
Picture Boxes from 10% to 1000%. Changing picture scale doesn’ t alter the picture offset. 

• Printable —when unchecked, prevents the pictures in active Picture Boxes from printing.
Frames and background colors are still printed. 

• Locked - prevents any accidental replacing or moving of the Picture Box.

• Visible - makes an object (a picture with its box) visible or invisible.

• Scale with Box - resizes the picture to its box height and width

• Display - displays or does not display the picture on the screen. The corresponding Picture
Box is still displayed.

• Printout — when unchecked, prevents the pictures in active Picture Boxes from printing.
Frames and background colors are also not printed.

• Units - indicates measurement units used for all the numeric information displayed.

Graphics Item Information

The Graphics Item Information dialog box is displayed when one or more rectangles, rounded
corner rectangles, ovals or arcs are active and you choose Object Info… You can adjust the fol-
lowing attributes: 

• Origin Across, Origin Down — repositions the original upper left corner of the object bor-
der or of the bounding box around multiple objects. These values are relative to the current
ruler origin. 
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• Width and Height — change the size of the active graphics box. Changing size of a box
doesn’t alter its origin. For a nonrectangular object, these fields control the bounding box
size. These fields are unavailable when more than one object is active. 

• Box Angle — rotates the active graphics box or the bounding box around multiple graphics
boxes around its center . Rotating a constraining graphics box rotates all constrained items
as well. 

• Printable — when unchecked, prevents from printing. 

• Locked - prevents any accidental replacing or moving of the graphics item.

• Visible - makes an item visible or invisible.

• Units - indicates measurement units used for all the numeric information displayed.

Line Information

The Line Information dialog box is displayed when one or more lines are active and you choose
Object Info… The following attributes can be changed: 

• Style — changes the style of active lines. 

• Pattern - changes the pattern of active lines.

• Caps & Ways - displays a line preview . Clicking on the each end of the line displays the
endcaps pop-ups, allowing you to specify up to seven different caps to each end of the line.

• Color — specifies the color of active lines. 

• Shade — specifies the color saturation of active lines. 

• Width — changes the thickness of active lines. 

• Origin Across - horizontal position of a line starting/ending point;

• Origin Down - vertical position of a line starting/ending point. When more than one line is
active, the fields contain mixed values, or are empty .

• Printable — when unchecked, prevents from printing. 

• Locked - prevents any accidental replacing or moving of a line.

• Visible - makes a line visible or invisible.

• Units - indicates measurement units used for all the numeric information displayed.
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Group Information

The Group Information dialog box is displayed when active items are of dif ferent types (for
example, Text Boxes and Lines) and you choose Object Info… The following attributes can be
changed: 

• Origin Across, Origin Down — repositions the left upper left corner of the group bound-
ing box. These values are relative to the current ruler origin. 

• Box Angle — rotates the active objects’ bounding box around its center. 

• Printable — when unchecked, prevents from printing. 

• Locked - prevents any accidental replacing or moving of an object group.

• Visible - makes an object group visible or invisible.

• Units - indicates measurement units used for all the numeric information displayed.

Frame Info…

When the Frame Info… command is selected from the Object menu, a dialog box appears that
allows you to change attributes of the selected frame. These attributes include the style, fill pattern,
color, shade width,and border style:

• Style - changes the style of the frame. 

• Pattern - changes the pattern the frame.

• Color - specifies the color of active lines. 

• Shade - specifies the color saturation of active lines. 

• Width - changes the thickness of active lines. 

• The Sample field is located in the upper right corner of the Frame Information dialog box
and previews the frame with the settings chosen.

• The Sides group contains four check boxes. Unchecking any of them erases the appropriate
side of the text frame. For example, unchecking the Above check box displays the frame
without its top side.

Click OK to accept the settings, or Cancel to discard them.
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Fill Info…

When the Fill Info… command is selected from the Object menu the dialog box appears that
allows you to control the fill color and pattern of the selected object. The specific attributes that are
controlled by the Fill Info… command are the Pattern, Visibility (opaque or clear), Shade, and
Background Color:

• Pattern - changes the pattern of the interior of the object.

• Visibility radio group - allows to make the object opaque or clear .

• Color - specifies the color with which the object is filled. 

• Shade - specifies the color saturation of the object. 

• Background - specifies the background color. 

The Sample field is located in the upper right corner of the Fill Information dialog box and shows
the preview of the changes you make.

Shadow Info…

The Shadow Info… command from the Object menu allows to make a shadow for rectangular
objects, such as Text Boxes, Picture Boxes, and Rectangles. 

When selecting this option, a dialog box appears that allows you to switch the shadow on and off,
and control the shadow color, shade, and offset from the box.

The Sample field is located on the right of the Shadow Information dialog box and shows the pre-
view of the changes you make.

Text Runaround…

When the Text Runar ound… command is selected from the Object menu, the dialog box
appears that allows you to control the way in which text in a Text Box flows around overlapping
objects. The types of text flow control that are available are:

• None - text flows unobstructed. 

• Rectangular boundary of object - text is obstructed by and flows around the object. 

• Actual shape of object - text flows around the outline of an object, oval for instance. 

You can specify the Margin Between Text and Object value that offsets the text from the inner
edge of the border. This value is displayed in points. 
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Duplicate

The Duplicate command is used to make a single copy of the selected object. The contents of
Text or Picture Boxes are also duplicated. A duplicate of a Text Box that is a part of a chain con-
tains all the text, that would contain the part of the chain beginning with that box.

The Horizontal and Vertical Offsets that were last specified in the Replicate dialog box specify
where the copy is placed. If  Replicate… hasn’t been used since running DesktopPublisher Pro, the
duplicate is placed 5 points to the right and below the original.

Replicate…

Replicate… is used to make multiple copies of the selected object. The contents of Text or Picture
Boxes are also duplicated. A duplicate of a Text Box that is a part of a chain contains all the text that
currently appeasr in that box.When the Replicate… command is selected from the Object menu,
the dialog box appears that allows you to control these parameters:

• Replicate Count — the number of copies to make

• Horizontal Offset — the horizontal distance between copies. A positive value places copies
to the right of the original. A negative value places copies to the left. Preset to 10 points

• Vertical Offset — the vertical distance between copies. A positive value places copies
below the original. A negative value places copies above. Preset to 10 points. The horizon-
tal and vertical offsets you specify become the default Replicate and Duplicate offsets, until
you quit from the program

• Units - indicates measurement units used for all the numeric information displayed

Delete

The Delete command is used to remove the active object/s from a document. Links are reestab-
lished automatically around a Text Box within a chain.

Group

Use Group to associate all active objects so that they act as a single object. Group is available
if the Object tool is selected and more than one object is active. 

You can perform many of the same basic operations on a group that you can on a single item, for
example, Cut, Copy, Duplicate, Delete, etc. However, you can’t resize a group. 

An active group is displayed within the bounding box (as indicated by a dotted line) that com-
pletely encloses the objects in the group. 

When an active group consists of different kinds of objects (for example, Text Boxes, and Lines),
choosing Object Info… from the Object menu displays the Group Information dialog box. When
a group consists of similar types of objects (for example, only Text Boxes), choosing Object Info…
displays the corresponding information dialog box.
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Ungroup

The Ungroup command is used to ungroup a selected Group of objects so they act as individual
objects again. When the active group contains other groups, Ungroup ungroups the outermost group
only.

Bring to Front

The Bring to Front command is used to change the "stacking" or front to back relationship of
objects on a page. Bring to Front places the active object in front of all other objects on that page.

Send to Back

The Send to Back command is used to change the "stacking" or front to back relationship of
objects on a page. Send to Back places the active object behind all other objects on that page

Shuffle Forward

The Shuffle Forward command is used to move the active object one level upward in the stack-
ing order of the objects in a page.

Shuffle Backward

The Shuffle Backward command is used to move the active object one level downward in the
stacking order of the objects in a page.

Nudge Up

The Nudge Up command is used to move the object toward the top of the page in one point steps.
Pressing the Shift key increases the steps to ten points each.

Nudge Down

The Nudge Down command is used to move the object down toward the bottom of the page in
one point steps. Pressing the Shift key while selecting Nudge Down increases the steps to ten points
each. 

Align Objects…

The Align Objects… command is used to control the placement of active objects in relation to
one another. Align Objects… is available if the Object tool is selected, and two or more objects are
active. Some options are available in the Align Objects dialog box which appears when the Align
Objects… command is selected. These options allow you to arrange objects horizontally , vertical-
ly, by either the left/top edge, centers, or right/bottom of an object. 
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Text Menu

The Text menu provides commands for changing the attributes and appearance of text on the
page. It includes commands for changing the attributes of characters, text lines, paragraphs, and text
pages.

• Font 
• Size
• Style
• Color
• Shade
• Alignment
• Tabs…
• Character Spacing…
• Line Spacing…
• Baseline Shift…
• Character Info…
• Paragraph Info…
• Style Sheets
• Insert Page Number
• Spelling
• Thesaurus…

• Text Statistics…

When a Text Box is active, the Text menu can be used to affect the appearance of highlighted text
or text that is entered at the text insertion point. 
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Font

When this command is selected, a submenu is activated that allows you to change the font of text.
Selecting Font from the Text menu activates a submenu displaying the list of fonts that are avail-
able on your system. To select a specific font, drag to and highlight it, and then release the mouse
button.

The command works in two dif ferent ways. If a segment of text is highlighted when you make
the font selection, only that text segment is changed. If no text segment is highlighted, then text
entered from the current position of the text insertion bar will appear in the new font.

When you activate the Font submenu, a check mark appears next to the font that is currently in
effect, either for the highlighted segment of text or at the current position of the text insertion bar .
The active font is also displayed in the Font Box in the Text toolbar.

Size

When this command is selected, a submenu is activated that allows you to change the size of text.
The options that are available on this submenu are 9, 10, 12, 14, 18, 24 and 36, point sizes, Larger
and Smaller, and Other. Selecting any of the point sizes from this submenu changes the character
size to that selection. Selecting Other opens the Other Value dialog box that allows you to set the
font size from 1 to 400 points in increments of 1 point. 

As with the Font command, the Size command works in two different ways. If a segment of text
is highlighted when you make the size selection, only that text segment is changed. If no text seg-
ment is highlighted, then text entered from the current position of the text insertion bar will appear
in the new size.

When you activate the Size submenu, a check mark appears next to the font size that is current-
ly in effect, either for the highlighted segment of text or at the current position of the text insertion
bar. The active font size is also displayed in the Size Box in the Text toolbar.

Larger and Smaller change font size to the next value, available in the submenu. Selecting
Larger when your font size is 12 will transform it to the size of 14 points, Smaller - to 10 points.

Style

When this command is selected, a submenu is activated that allows you to change the style of
text. The available options are:

• Plain Text
• Bold
• Italic 
• Underline
• Outline 
• Shadow
• Condensed
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• Expanded
• Small Caps
• Subscript
• Superscript

Selecting any of the font styles from this submenu changes the character style to that selection.
The Style command works in two different ways. If a segment of text is highlighted when you make
the style selection, only that text segment is changed. If no text segment is highlighted, then text
entered from the current position of the text insertion bar will appear in the new style.

When you activate the Style submenu, a check mark appears next to the style that is currently in
effect, either for the highlighted segment of text or at the current position of the text insertion bar .

Color

When this command is selected, a submenu is displayed that allows you to change the color of
text. To select a specific color , drag to and highlight it, and then release the mouse button.
Alternatively, you can change the color of text by using the Color Box in the Graphics toolbar.

The command works in two dif ferent ways. If a segment of text is highlighted when you make
the font selection, only that text segment is changed. If no text segment is highlighted, then text
entered from the current position of the text insertion bar will appear in the new color .

When you activate the Color submenu, a check mark appears next to the color that is currently
in effect, either for the highlighted segment of text or at the current position of the text insertion bar. 

The menu is modified each time a new color is added, or one of the existing is changed or delet-
ed, using the Create Color dialog box accessed from the Edit menu.

Shade

When this command is selected, a submenu is activated that allows you to change the shade (print
density) of text. The options that are available on this submenu range from 0 to 100 percent of nor-
mal in increments of 10 percent. Selecting Other opens the Other Value dialog box that allows you
to set the shading from 0 to 100 percent in increments of 1 percent.

The Shade command works in two dif ferent ways. If a segment of text is highlighted when you
make the shade selection, only that text segment is changed. If no text segment is highlighted, then
text entered from the current position of the text insertion bar will appear in the new shade.

When you activate the Shade submenu, a check mark appears next to the shade that is currently
in effect, either for the highlighted segment of text or at the current position of the text insertion bar.
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Alignment

When this command is selected, a submenu is activated that allows you to change the alignment
of the current paragraph of text. The current paragraph is the one that contains the highlighted text,
if there is highlighted text. Otherwise the current paragraph is the one that contains the text inser-
tion bar.

The options that are available on this submenu are Left, Center, Right, Justified, and Force
Justified. Alternatively, you can click on the Align Left, Align Center, Align Right, and Justify
buttons (respectively) in the Text toolbar.

Selecting Left causes the alignment of the current paragraph to be flush with the left mar gin, like
this paragraph.

Selecting Center causes the lines in the current paragraph to be centered between the left and
right margins, like this paragraph.

Selecting Right causes the alignment of the current paragraph to be flush with the right mar gin,
like this paragraph.

Selecting Justify causes the alignment of the current paragraph to be flush with both margins, except
for the last line of the paragraph, which is Justified to the left, like this paragraph.

Selecting Force Justify acts like Justify, but does not exclude the last line. This means that all lines
will fill the page from mar gin to mar gin, like this paragraph.

Tabs

Selecting Tabs from the Text menu activates the dialog box that allows you to add or remove tab
stops for the current paragraph. The current paragraph is the one that contains the highlighted text,
if there is highlighted text. Otherwise the current paragraph is the one that contains the text inser-
tion bar. You can have up to 16 tab stops defined for a given paragraph.

When you add a tab stop you can specify up to three attributes. These are:

• Alignment: The alignment of the tab stop determines how text is aligned to it. Alignment
can either be Left, Right, or Center.

- Left alignment causes the first character of text typed at the tab stop to be located to
the tab stop position. As additional characters are typed in, the text segment is expand-
ed to the right or the tab stop.

- Right alignment causes the last character of text typed at the tab stop to be flush to the
tab stop position. As additional characters are typed in, the text segment is expanded to
the left of the tab stop.

- Center alignment causes the text segment to be centered with respect to the tab stop
position. As additional characters are typed in, the text segment is expanded both to the
left and the right of the tab stop position, so that the text segment remains centered with
respect to it.
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The alignment of a tab stop is set by clicking and holding on the down facing arrowhead to
the right of the Alignment display box in the Tabs dialog window. This activates a pop-up
menu with the three options. Drag to the desired selection and release. The selected align-
ment now appears in the display box.

• Leading Character Sequence: The lead character sequence can be any valid sequence of
characters, including a space. It is used to fill white space between the end of a text segment
at a tab stop and the text segment directly to the left of it. 

You specify the lead character sequence by entering it directly into the edit box to the right
of Leader in the Tabs dialog window, and. Alternatively, you can activate a pop-up menu
by clicking and holding on the arrowhead to the right of Leader, and then drag to and select
one of the prespecified lead character sequences.

• Position: The position can be set at any location on the horizontal ruler . The position
attribute of a tab stop is specified by typing the value into the edit box to the right of
Position. The unit of measure for the position is the same as that being used for the hori-
zontal ruler.

Character Spacing

Selecting Character Spacing from the Text menu activates the dialog window that displays the
current character spacing settings (kerning) in points. The kern is the amount of space added to or
subtracted from the normal distance between characters. The application will accept a kerning
amount between -100 and 100. A negative amount compresses text, a positive amount expands text.
The default value of 0 keeps the characters at a normal distance from each other .

To change the character spacing, enter the new kerning amount directly into the Character
Spacing edit box in this dialog window . Alternatively, use the Character Spacing controls on the
Text toolbar to decrease and increase the kerning amount.

Line Spacing

Selecting Line Spacing from the Text menu activates the dialog window that displays the cur-
rent Line spacing settings (leading) in points. The leading is the amount of space added to or sub-
tracted from the normal distance between lines. The application will accept a leading amount
between -500 and 500. A negative amount compresses text, a positive amount expands text. The
default value of 0 keeps the lines at a normal distance from each other .

To change the line spacing, enter the new leading amount directly into the Line Spacing edit box
in this dialog window. Alternatively, use the Line Spacing controls on the Text toolbar to decrease
and increase the leading amount.

Baseline Shift

When this command is selected, a dialog window is activated that allows you to change the base-
line shift of text. The baseline shift is the distance that characters are shifted up or down from the
baseline of the current line of text. To specify a baseline shift enter the new value in the edit box to
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the right of Baseline Shift in this dialog window. Alternatively, you can increase and decrease the
baseline shift in increments of one unit by clicking on the upward and downward facing arrows to
the right of the edit box. 

The command works in two different ways. If a segment of text is highlighted when you change
the baseline shift, only that text segment is af fected. If no text segment is highlighted, then text
entered from the current position of the text insertion bar will be af fected.

Character Info

Selecting Character Info from the Text menu activates a dialog window that displays, and
allows you to modify, the attributes of text characters. The Character Info command works in two
different ways. If a segment of text is highlighted when you select this command, only the charac-
ters in that text segment are changed. If no text segment is highlighted, then text entered from the
current position of the text insertion bar will appear with the new set of attributes.

The attributes that apply to text characters are: Font, Size, Color , Shade, Spacing, Baseline
Shift, and Style. 

Paragraph Info

Selecting Paragraph Info from the Text menu activates a dialog window that displays, and
allows you to modify, the attributes of the current paragraph. The current paragraph is the one that
contains the highlighted text or the text insertion bar . To modify an attribute, enter a new value in
the edit box where the current value is being displayed. The attributes that are displayed and are
available for modification are:

• Left Indent - The left indent is the horizontal distance between the left side of the Text Box
and the left margin of the current paragraph. A positive value sets the left margin of the para-
graph to the right of the page mar gin. 

• First Line - the horizontal distance between the left mar gin of the current paragraph (as
defined by the left indent), and the first character of the first line of text in the paragraph. If
the value is negative, the first character of the first line appears to the left of the paragraph
margin. This becomes a hanging indent. If it is positive, the first character of the first line
appears to the right of the paragraph mar gin. This becomes a normal indent.

• Right Indent - the horizontal distance from the the right side of the Text Box and right mar-
gin of the current paragraph. A positive value sets the right mar gin of the paragraph to the
left of the page margin. 

• Leading - The leading is the distance between the baseline of successive lines of text.

• Space Before - The value of this attribute specifies the distance between the last line of the
previous paragraph and the first line of the current paragraph.

• Space After - The value of this attribute specifies the distance between the last line of the
current paragraph and the upper boundary of the next object or paragraph on the page.
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• Keep With Next - When this option is in ef fect, the current paragraph is kept on the same
page as the following object or paragraph. The check box to the left of Keep with Next is
checked when the option is in ef fect. Clicking on the check box puts the option in ef fect if
it is not, or causes it not to be in ef fect if it already is.

• Keep Lines Together - When this option is in ef fect, the lines of the current paragraph are
kept on the same page. An X appears in the checkbox to the left of Keep Lines Together
when the option is in ef fect. Clicking on the check box puts the option in ef fect if it is not,
or causes it not to be in ef fect if it already is.

• Alignment - To the right of Alignment in the lower right corner of the Paragraph Info win-
dow is a display box with a downward facing arrowhead. Click and hold on the display line.
A pop-up menu is activated that allows you to select from five types of paragraph alignment,
Left, Right, Center, Justified, and Force Justified. Drag to and highlight the desired align-
ment and then release. The selection is now displayed in the display box.

• Drop Caps - displays the first letter of the current paragraph in a text size which equals the
height of a set number of the lines of text. The number of lines used is defined in the edit
field right under the Drop Caps check box.

• Units - To the right of Units in the lower right corner of the Paragraph Info window is a dis-
play box with a downward facing arrowhead. Click and hold on the arrow . A pop-up menu
is activated that allows you to select from four units of measure, Inches, Points,
Centimeters, and Picas. Drag to and highlight the desired measurement unit and then
release. The selection is now displayed in the display box. The unit of measure will now be
used for all dialog boxes and menus in describing the attributes of the current paragraph.

Style Sheets

A style sheet contains a collection of attributes that are applied to the current paragraph. The cur-
rent paragraph is the one that contains the highlighted text or the text insertion bar .

Selecting Style Sheets from the Text menu activates a pop-up menu that includes a list of avail-
able paragraph styles. Drag down to and highlight the desired style and then release. The attributes
of the selected style sheet are applied to the current paragraph. The name of the current style sheet
is displayed in the Style Sheet Box in the Text toolbar.

To create or edit style sheets: use the Edit Style Sheets command from the Edit menu.
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Insert Page Number

The Insert Page Number command is used to place the current page number into the Text Box
that is currently active. It displays a pop-up menu, containing all the page numbering formats: 

1,2,3,4 Numeric 
I,II,III,IV Upper case Roman 
i,ii,iii,iv Lower case Roman
A,B,C,D Upper case Alphabetic
a,b,c,d Lower case Alphabetic

Spelling

When working with a DesktopPublisher Pro document you can spell check different parts of this doc-
ument. Selecting the Spelling option from the Text menu displays the submenu containing the
options:

• Word/Selection

• Paragraph

• Story

Spelling is verified by scanning the 100,000-word DesktopPublisher Pro Main Dictionar y, and then
the User Dictionary.

When the Spell Check dialog box is displayed, you are presented with a list of words from the
DesktopPublisher Pro dictionaries similar in spelling to the suspect word. 

To replace the suspect word with another contained in the list: Select the word in the list and click
Replace, or double-click on the word. 

The Add and Remove buttons allow you to edit the User Dictionary dictionary contents.

To add a new word to the DesktopPublisher Pro User Dictionary: click on the Add or Full Add but-
tons. If the Add button is pressed, the word is immediately added to the dictionary. Otherwise, you
are presented with the Add to Dictionary dialog box, containing various suffixes you may add to the
word. 

To remove a word from the dictionary: select it in the list box and click on the Remove button.

You can edit the contents of the User Dictionary using the Edit User Dictionary command from
the Edit menu.

Thesaurus

When using this option, DesktopPublisher Pro searches for and presents you with a list of syn-
onyms/antonyms to the specified word from the thesaurus database distributed along with
DesktopPublisher Pro.
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The Thesaurus dialog box contains the table with the word list, buttons Find, Replace and Close,
and, in case of large database usage, two pop-up menus. 

The contents of the word list are defined by the Category and Senses pop-up menus settings.

If the list is not empty, you can select any word in the list and double click on it, or , alternative-
ly, click the Find button. When you select the desired word, click Replace to replace the original
word in your text with the newly selected one.

Text Statistics

The Text Statistics dialog box contains information about the entire text present in your docu-
ment.

• Number of Text Frames - means the number of Text Boxes currently used in your docu-
ment

• Number of Text Chains - when two or more Text Boxes are linked using the Linking tool,
they create a text chain. The number of the chains is displayed in this window

• Number of Text Paragraphs - the number of paragraphs in your entire document

• Number of Words - indicates the word count. This can be particularly useful for written
assignments with a set number of words
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Graphics Menu

The Graphics menu is used to control the attributes of graphics objects. It includes the follow-
ing commands, each of which displays a submenu:

• Line Width
• Line Style
• Line Color
• Line Shade
• Line Pattern
• Fill Color
• Fill Shade
• Fill Pattern
• Background Color

Line Width

When this command is selected, a sub-menu is activated that allows you to select the width of the
lines of an object. The options available on this submenu are 1, 2, 4, 6, 8, 12, and Other. A check
mark is placed next to the option that is currently in effect. Alternatively, you can select Other from
this submenu. A dialog box will appear that allows you to select Line Width in the range of 0 to
100 points in increments of 1 point. The Line Width value is always displayed in points.

Line Style

The Line Style command is used to select from the various line styles that are available in
DesktopPublisher Pro. When this command is selected, a submenu is activated that allows you to make
a specific choice of line style. A check mark in the submenu indicates the line style that is current-
ly in effect. 

Line Color

The Line Color command is used to select from the various line colors that are available in
DesktopPublisher Pro. When this command is selected, a submenu is activated that allows you to make
a specific choice of a line color . A check mark in the submenu indicates the line color that is cur-
rently in effect. 

The menu is modified each time a new color is added, or an existing one is deleted, using the
Create Color dialog box accessed from the Edit menu.
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Line Shade

The Line Shade command is used to select from the various line shades that are available in
DesktopPublisher Pro. When this command is selected, a submenu is activated that allows you to make
a specific choice of a line shade. The options available on this submenu range from 0% shading to
100% shading in increments of 10%. A check mark is placed next to the option that is currently in
effect. Alternatively, you can select Other from this submenu. When this is done, a dialog box
appears that allows you to select shading in the range of 0 to 100 percent in increments of 1 percent. 

Line Pattern

The Line Pattern command is used to select from the various line patterns that are available in
DesktopPublisher Pro. When this command is selected, a submenu is activated that allows you to make
a specific choice of a line pattern. A check mark in the submenu indicates the line pattern that is cur-
rently in effect. 

Fill Color

The Fill Color command is used to assign a fill color to a selected graphic object. The fill color
effects all solid sections in the current pattern When this command is selected, a palette of available
fill colors is displayed. A check mark indicates the fill color that is currently in effect for the select-
ed object.

To create your own color to fill objects use Create Color from the Edit menu. 

Fill Shade

When this command is selected, a submenu is activated that allows you to select the shading of
the interior of an object. The options available on this submenu range from 0% shading to 100%
shading in increments of 10%. A check mark is placed next to the option that is currently in ef fect.
Alternatively, you can select Other from the submenu. When this is done, a dialog box appears that
allows you to select shading in the range of 0 to 100 percent in increments of 1 percent.

Fill Pattern

When this command is selected, a palette of fill patterns available to fill the interior of an object
is displayed. A check mark indicates the fill pattern that is currently in effect for the selected object.

Background Color

The Background Color command is used to assign a background color to a selected graphic
object. The background color effects all clear sections in the current pattern. When this command is
selected, a palette of available background colors is displayed. A check mark indicates the back-
ground color that is currently in ef fect for the selected object.
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Page Menu

The commands in the Page menu are used to set the layout of the page display, as well providing
facilities for inserting and deleting pages. They are listed as follows: 

• View
• Show Rulers
• Show Facing Pages
• Show Guides
• Snap to Guides
• Insert Page
• Go To page
• Delete Page
• Show Master Page Layer
• Master Page Options
• Create New Master Page
• Delete Master Page

View

Selecting View from the Page menu activates a submenu that allows you to change the size of
the page as it is displayed on the screen. Available options are:

• Fit in Window

• 25%

• 50%

• 75%

• Actual Size

• 200%

• Other

Selecting Fit in Window changes the size of the display so that exactly one page is displayed in
the document layout window . Selecting 25%, 50%, 75%, Actual Size, or 200% respectively,
changes the display by the corresponding amount of the actual page size.

Selecting Other activates a dialog box that allows you to change the size of the document to any
value between 10 and 400 percent in increments of 1%. A check mark is displayed next to the option
in the View menu that is currently in ef fect.
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Show Rulers

If the horizontal and vertical page Rulers are currently being displayed, then this item has a
checkmark next to it. Selecting this item removes the Rulers from the document layout window . If
the horizontal and vertical page Rulers are not being displayed, then the second item in the Page
menu is displayed as Show Rulers. Selecting this item displays the rulers in the document layout
window.

The measurement units reflected in the rulers are set through the Document Setup dialog box
when the document is created and can be changed through the Ruler Settings menu option ( Edit
menu).

You can change ruler settings also by clicking the upper left corner (intersection) of the rulers,
while pressing the Option key. When you do so,the type of unit-measurement is displayed. The fol-
lowing units are available: inches, picas, points, and centimeters.

Show Facing Pages

Selecting Show Facing Pages from the Page menu causes facing pages to be displayed at the
same time in the document layout window . The option is activated when the Double Sided Pages
option from the Document Setup dialog box is checked. Once checked the pages of your document
are displayed in pairs, starting from the first even page.

A check mark appears in the Page menu next to this item when the Show Facing Pages option
is in effect.

Show Guides

Use Show Guides to display margin guides, column guides, ruler guides and box outlines, and to
enable you to pull ruler guides from the rulers. When guides and box outlines are displayed, the
menu entry has a checkmark next to it. 

Snap to Guides

The Snap to Guides option of Mac Publisher Pro causes the sides of an object to be aligned to
the page guides. 

Snap to Guides is activated or made inactive either by selecting Snap to Guides from the Page
menu or by checking the corresponding check box in the Guide Settings dialog box. If this option
is currently in effect, selecting Snap to Guides deactivates it. Otherwise, selecting Snap to Guides
activates it. A check mark indicates whether this option is currently in ef fect.

154

Desktop Publisher Pro by Cristallight 



Insert Page

The Insert Page command is used to insert copies of the currently selected Master Page into a
document. When this command is selected, the dialog box that allows you to select the location and
number of pages to insert is activated.

The Master Page pop-up menu allows you to select a Master Page for your newly created page. 

The Link to Current Text Chain check box allows you to link the automatic Text Box on the
newly created page to the currently active Text Box. This option is enabled when the Automatic
Text Box setting from your Document Setup dialog box is on, and the Text tool is selected.

Go to Page

The Go to Page command is used to go directly to a specific page. When Go to Page is select-
ed the dialog box is activated that allows you to select the desired page. It also provides you with
the option to display the left or right Master Page.

The Navigation controls on the bottom of the document window allow you to navigate through
your document. There are Next and Previous page buttons, and the Go To Page pop-up menu. To
go to the desired page, select its number from the list, and release the mouse. 

Delete Page

The Delete Page command is used to remove pages from a document. When this command is
selected, a dialog box appears that allows you to select a range of pages to be deleted.

Text in text chains in deleted pages is reflowed through the remaining elements of the chain,
unless all elements of the chain are deleted, in which case the entire chain is deleted.

Show Master Page Layer

DesktopPublisher Pro, in addition to regular document pages, supports Master Pages that contain
objects common for subsequent document pages. When creating a new page using Insert Page
command from the Page menu, you are given the option of selecting a Master Page for the page
being created. Master Pages are created and removed using the Create New Master Page and
Delete Master Page options respectively, and can be modified by the Master Page Options menu
item from the Page menu.

If Show Master Page Layer is checked and you still do not see the Master Page items, make sure
they are not covered by another object. The Master Items in Front check box in the Preferences
dialog box controls how Master Page items are displayed - above or under all document objects.

To view a particular Master Page: use either the Go To Page dialog box, or the Page Navigation
buttons, located to the right of the Controls Area and at the bottom of the Document Window. 

To select or change the Master Page for a particular document page: use the Left and Right
Master Page pop-ups, located to the right of the View Size pop-up in the Controls Area. The Left
Master Page pop-up is enabled only in the case of a double sided document.
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Create New Master Page

Use the Create New Master Page option to add a Master Page to your current document. You
are able to set the current Master Page name, its margins, and number of columns used on this page.
After creation, the name of the page is added to the list of Master Pages used in the Insert Page dia-
log box from the Page menu. The new Master Page is also listed in the Left and Right Master Page
pop-ups located in the Controls Area at the bottom of the Document Window. These pop-up menus
allow a Master Page to be selected for the current document page.

Master Page Options

The Master Page Options dialog box allows you to set the current Master Page name, mar gins,
and number of columns used on this page.

Delete Master Page

This command presents you with the Delete Master Page dialog box, that allows you to select the
Master Page to be deleted. 

To delete a page: select the desired Master Page from the Master Page pop-up menu, and click
OK.
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Windows Menu

The Window menu contains two sections. The first one is for commands that change the order
and location of the currently opened documents on the screen. It allows user to:

• Stack

• Tile

• Tile vertically

all open document windows.

The second section contains a list of those documents. DesktopPublisher Pro automatically adds an
opened document name to the Windows menu. Selecting the name of a document from the
Windows menu brings that document to the front of the desktop, and makes it the active document.

Online Help

Selecting DesktopPublisher Pro Help from the Help menu opens the Help window. The Help win-
dow contains a scroll list of DesktopPublisher Pro Help topics. Use the scroll bar to traverse the list until
you find the topic of interest. 

When you find the topic of interest, highlight it by clicking on it, then release the mouse button.
The Help window changes to display a brief description of the topic. Return to the Contents win-
dow by clicking on the Topic button.

Click on the close box at the upper left of the Online Help window to close it. 

Balloon Help

Selecting Balloon Help from the Help menu activates the Balloon Help option which allows you
to get a short description of any interface element of the DesktopPublisher Pro except for the toolbar
elements. You can get that description displayed by placing the cursor on the desired element.
Switching off the option deactivates Balloon Help.
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Technical Support
Assistance Via World Wide Web

Get up-to-the-minute technical information at the Cristallight  web-site, at: 

http://www.cristallight.com/

twenty-four hours a day, seven days a week. Through this site you'll have access to our FAQ doc-
uments, (Frequently Asked Questions) which contain our latest troubleshooting information. You'll
have access to our FTP (File Transfer Protocol) area where you can download patches and new
enhancements as soon as they become available, and an E-Mail area where you can leave us your
tech support problems and questions if you do not find your answers within the F AQ.

Help Via Telephone/Fax Or Mail In The US & Canada

For phone assistance, call Cristallight Tech Support at 413-383-0596. We have an  Faxback system 
that is available twenty-four hours a day , seven days a week. 
If you should need live support, we are available Monday through Friday, 8 AM until 6 PM (PST). 
Please note that live Tech Support may be closed on major holidays. We ask that you do the following 
when calling: be at your computer; have your system information ready for our technicians including 
system make and model and processor type; MAC/OS version number; RAM; and any screen or error
messages you've encountered and where (if not currently displayed on your screen). It will expedite
your handling significantly. 
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Refund Policy 
 
1. It is the responsibility of the Purchaser to fully evaluate the suitability of the product by 

downloading the demo. 
2. Once the Purchaser pays for the product, he or she will receive a Key which will allow the 

user to download and in stall a fully functional version of the product. Once the user the 
receives the Key, for distribution and refund purposes, the product is treated in the same way 
as a software product purchased at a retail outlet that has been opend (that is, the seal has been 
broken): 

We will not refund the funds for the product, unless the product is: 
(a) shown to be substantially defective in some manner not revealed by the evaluation of the demo 

version, and 
(b) we do not repair the defect within 15 business days and provide to the purchaser a version of the 

product that is free from any reported defects. 
If we do not perform to remedy defects as specified in items 2(a) and 2(b), then we will fully refund 
the amount paid for the product. The refund will appear as a credi t to the original credit card 
account against which the original charge was made. 
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